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HTML Introduction 
 
 
 

In this chapter you are introduced to the concepts of linear media and 
hypermedia. You will learn about HTML and the basics of document 
structure. 

 
 
 
Objectives 

 
Upon completing this section, you should be able to:  
 
1. Explain hypermedia vs. linear media 
 
2. Define HTML 

 
3. Describe the Basic Document Structure 
  
 

 
 



 

2 XtraNet U – The place to learn how to develop for the web – http://www.xnu.com 
 

Linear Media 
 

Linear media describes media with a defined beginning and a linear 
progression to the end. Forms of linear media such as film, audio and 
videotape, as well as most books are organized with this expectation. The 
World Wide Web, however, is organized differently. 
 
 

Hypermedia 
 

Hypermedia is about choice.  Users simply select what interests them. A 
good example is an audio CD where you can choose song 5 and listen to 
it almost immediately. Contrast this with an audiotape where you would 
have to scan through from your current location on the tape to the 
beginning of the song. 
 
When this concept is applied to text you get hypertext, where by 
{Clicking} on a link or hotspot (hyperlink) you are transported to a new 
location within the same page or to a new page altogether. 
 
When you interlink a large number of pages of text on different computers 
all over the world, you get a spider web-like system of links and pages. 
This is known as the World Wide Web – a system whereby pages stored 
on many different web servers, connected to the Internet, are linked 
together. 
 
The system is useful because all of the pages are created in the same 
format. This format or “language” is called HTML (Hypertext Markup 
Language), a subset of an international standard for electronic document 
exchanged called SGML (Standard Generalized Markup Language). 
 
This course introduces you to the format of an HTML page.  You will learn 
about the components that make up HTML, and how to use FrontPage to 
create pages to publish on the World Wide Web. 
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What is HTML Markup?  
 
HTML is a set of logical codes (markup) in parentheses that describe the 
appearance of a web document and the information it contains.  
 
E.g. <B>This text would appear bold in the browser</B> 
 
The codes are enclosed by less than “<”, and greater than “>” brackets. 
These bracketed codes of the markup are commonly referred to as tags. 
HTML codes are always contained inside these brackets and are case-
insensitive; meaning, it does not matter whether you type them in upper 
case or lower case. However, tags are easier to recognize in a web 
document if they are capitalized.  
 
There is an opening element (tag) and a closing element (tag).  The 
closing element is distinguished by the “/” inside the “<” opening bracket, 
as in </B> to end where the text is in bold. 
 
The first word or character that appears inside the “<” opening bracket is 
called the element. An element is a command that tells the browser to do 
something, such as <FONT>.  
 
Words that follow the element and are contained inside the “>” closing 
bracket are called attributes. Attributes are not repeated or contained in 
the closing element (tag). Confused? Attributes are another way of 
describing the element’s properties. For instance, a t-shirt can have 
several properties or “attributes” – the t-shirt’s color, size, material etc. are 
all attributes.  
 
Attributes that appear to the right of the element are separated by a 
space, and followed by an equal sign. The value of the attribute is 
contained in quotes. In the following example the element is FONT, the 
attribute is COLOR, and the value of that attribute is BLUE. 
 

 
 
Most HTML elements have more than one attribute. 
E.g. <FONT COLOR="BLUE" SIZE=”+1”>This text would be blue and 
one size larger than normal.</FONT> 
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A Basic Document 
 

An element called HTML surrounds the whole document. This element 
contains two sub-elements, HEAD and BODY. These elements are 
required to form any HTML document. 
 

 
 

 
Course Goal 
 

The goal of this course is to teach you how to use FrontPage to apply 
HTML Elements and Attributes in designing web pages. This course will 
review almost every element in the current HTML specification. Not all 
web pages use all of the elements, however it is to your advantage to 
understand that they exist so that you can create more effective pages. 
 
 
 
 



 
 

Learn Web Development in a classroom @  http://www.xnu.com Call 1-416-675-1881 5 
 

Review Questions 
 

1. What does HTML stand for? 
 
 
 
2. What is an Element? 
 
 
 
3. What are the Attributes of an Element? 
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Summary  
 

As a result of this chapter, you should be able to:  
 
• Explain hypermedia vs. linear media 

 
• Define HTML 

 
• Describe the Basic Document Structure 
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2 
 

Overview of the FrontPage Editor 
 
 

In this chapter you learn how to use FrontPage. 
 
Objectives 
 

Upon completing this section, you should be able to:  
 

1. Switch between and describe the three editor views 
 

2. Work with the menu options 
 

3. Enable and disable toolbars in FrontPage 
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Introduction to the Editor 
 

In the first chapter you were introduced to HTML elements and their 
attributes as well as the basic document format. The good news is you 
don’t need to type all the codes in by hand. FrontPage is going to make 
creating your HTML web pages easy. In this chapter you get an overview 
of the FrontPage interface. There are a number of interface options that 
can be greatly customized. In this chapter we focus on the default settings 
and use those for the bulk of the course so that you can focus on learning 
how to create great web pages. We do have a chapter later on that 
teaches you how to customize the interface to maximize your productivity. 

 
 
The Editor 
 

The editor (pictured below) has several menus, and toolbars. We will 
examine each aspect individually in this chapter. 
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Views Bar  
 
On the left of the screen is the “Views Bar”. This bar is helpful when you 
are working on a web site that is made up of several linked HTML pages.   

• Folders View – shows the folders and files that make up your 
website, similar to using Windows Explorer. 

• Reports View – allows you to create reports on your web sites. 
• Navigation View – shows you the links between pages and allows 

you to trace the path a surfer may take through your site. 
• Hyperlinks View – displays the pages that have inbound links to the 

current document and the pages that the current document has 
links outbound to. 

• Tasks View – is a to-do list for the web developer(s) working on the 
website. 

 
This course focuses on creating web pages. You may want to work with 
the “Views Bar” off to give yourself more screen space (real-estate) to 
work with. 
 
You can turn it off by right clicking anywhere in the open space and 
selecting “Hide Views Bar” or by deselecting “Views Bar” from the View 
Menu. 
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To turn the “Views Bar” back on use the View menu and click on the 
“Views Bar” option. You can also select any of the different “Views”: 
Folders, Reports, Navigation, Hyperlinks, or Tasks from this menu. 
 

 
 
 
Editor Views  

 
FrontPage supports three different views or ways to look at your 
document: 
 
1. Normal – This is the Default Editor view, a WYSIWYG interface. 
 
2. HTML – Displays the raw HTML code. 
 
3. Preview – You cannot edit in the Preview view, it displays your page 

the way it will look in a browser. 
 

You can switch between these three views using the icons in the bottom 
left corner of the editor screen. 
 

 
 
Note:  By default FrontPage starts with a new, blank document.  If you 
should happen to close a document the Editor Views icons will not be 
visible.  To open a New document select File/New/Page.  {Click} on 
“Normal Page” under the New dialog box. 
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Normal View  
 

When you first launch FrontPage, any documents you create or edit will be 
displayed in Normal view. The Normal view is a WYSIWYG view. 
WYSIWYG is an acronym for `What You See Is What You Get'; that is, the 
way documents are displayed is basically how they're going to look in the 
Web browser. The display includes images, alignment of block elements, 
tables, and form elements (buttons, check boxes, etc.), background colors 
and images. This display is a good way to get a sense of how your 
document will look on the World Wide Web. It's also easy and convenient 
to edit your document in this mode, much as you would with a word 
processor. 
 
HTML View  

 
This view shows the actual HTML code in your document. The HTML 
Source view is color-coded making it more useful than opening the file in a 
text editor.  You use the HTML View to manually edit the code.  Changes 
you make to your code are reflected in the Normal and Preview mode. 
 

 
 

Preview View  
 

The Preview View enables you to see how a document will be displayed in 
the Internet Explorer web browser. The display includes images, 
alignment of block elements, tables, form objects (buttons, check boxes, 
etc.), background colors, and images. This display is a good way to get a 
sense of how your document will look on the World Wide Web; however, 
you cannot edit your page in this mode. 
 
Note: The Preview View is not 100% accurate; always test your page in 
an actual browser.  Testing your page in both Netscape’s Navigator and 
Microsoft’s Internet Explorer is also recommended. 
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Menu Items 
 
The menu items across the top of the FrontPage window include all the 
commands accessible on the toolbars as well as additional commands.  
 
In FrontPage 2000 the menus do not automatically display all available 
options. You will find a double arrow pointing down if there are more 
options available. You can click on the arrows or leave the menu selected 
for a short period of time and the full menu will be displayed. 
 
Before  After 
 

 

 
 
We won’t go through every menu option. We will make reference to the 
menu options when necessary in the course. You may want to make 
yourself familiar with what is listed on each menu. 
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Toolbars 
  

You can access commands in FrontPage through the toolbars. ToolTips 
— short descriptions of what a toolbar button does—appear near the 
toolbar buttons if you move your mouse cursor over them. There are nine 
toolbars available, though not all are displayed by default, as FrontPage 
cannot anticipate your preferences.  Like most applications, you can 
customize your working environment.  When you open FrontPage for the 
first time, the Standard and Formatting toolbars are displayed. 
 
You can move any toolbar to any other position in the toolbar area at the 
top of the FrontPage screen, or move a toolbar off that area, where it 
becomes a floating toolbar (sometimes called a `palette'). These Floating 
toolbars can be positioned anywhere on the screen. 
 

 
 

How to Position Toolbars: 
 
{Click} on the toolbar and drag it to wherever you want. To change the 
floating toolbar back to a fixed toolbar, {Click} and hold on its title bar and 
drag it back to the top of the FrontPage screen or simply {Double Click} on 
its title bar and it will return to its previous position in the toolbars area.   
 
You can close a floating toolbar by {Clicking} on the close button in its 
upper right corner. 

 
The location of the toolbars will be saved when you exit FrontPage, so 
they'll be in the same place when you open the Editor again. 
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Enabling Toolbars  
 
To turn a particular toolbar on or 
off: 
• Choose the Toolbars from the 

View menu. . 
• {Click} on the Toolbar that you 

want to turn on or off. 
 
A toolbar that is currently “on” is 
indicated with a checkmark next to 
it. 

 
 
 
Standard Toolbar:   

 
The Standard toolbar contains many basic commands, including file 
commands: 
 New, Open, Save, Publish Web 
 Folder List 
 Print, Preview in browser, and Check spelling 
 Cut, Copy, Paste and Format Painter 
 Undo, Redo 
 Insert Component, Insert Table and Insert Picture 
 Create or Edit Hyperlink 
 Refresh, and Stop 
 Show / Hide marks 
 Help 
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Formatting Toolbar:   
 

Use the Formatting toolbar to modify the content of your page (and hence 
HTML code). 

Select Style  
Select Font – Office 2000 products now have a WYSIWYG font list! 

  
Select Font Size 
Bold, Italics, Underline 
Align Left, Center, and Align Right (Align attribute) 
Numbered List, Bulleted List, Decrease Indent, and Increase Indent 
(Commonly known as Ordered List, Unordered List, Remove Block 
Quote, add Block Quote) 
Highlight Color 
Text Color 

 
Note: This toolbar will be examined fully in the Character Formatting 
chapter. 
 
 

Pictures Toolbar: (Note: only active when an image is selected)   
 

Insert Image 
Text 
Auto Thumbnail 
Position Absolutely, Bring to Front, Send to Back 
Rotate Left, Rotate Right, Reverse, and Flip 
More Contrast, Less Contrast, More Brightness, Less Brightness,  
Crop, Make Transparent, Black and White, Wash Out, Bevel, Resample 
Select, Rectangle, Circle, Polygon, Highlight Hotspots 
Restore 

 



 

16 XtraNet U – The place to learn how to develop for the web – http://www.xnu.com 
 

Tables Toolbar:   

 
Draw Table, Eraser 
Insert Rows, Insert Columns, and Delete Cells 
Merge Cells, Split Cells 
Align Top, Center Vertically, and Align Bottom 
Distribute Rows Evenly, Distribute Columns Evenly 
Background Color 
Auto Fit 

 
Note: the remaining toolbars are discussed as required throughout the 
rest of the course. 

Note: if you see this, , at the end of the toolbar the double arrow “>>” 
indicates that there are more buttons but no room to display them. The 
down arrow “∨ ” will allow you to add and remove buttons from the toolbar.  
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Review Questions 
 

1. Name three toolbars? 
 
 
 
2. What are the default toolbars? 

 
 
 

3. What are the three editor views? 
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Summary 
 

As a result of this chapter, you should be able to:  
 

• Explain the different toolbars 
 

• Turn the different toolbars on and off 
 

• Switch between the three different views of FrontPage 
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3 
 

The Anatomy of an HTML Document 
 

You will learn about HTML and basic document structure. 
 
Objectives 

 
Upon completing this section, you should be able to:  
 
1. Describe the Basic Document Structure 
 
2. Identify the sub-elements of the header 
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Document Structure  
 

Documents are marked up with elements and attributes according to a 
Document Type Definition (DTD). These are the rules that govern the way 
in which a document can be marked up. 
 
The authoritative source for information about the HTML Specification and 
the HTML DTD is the World Wide Web Consortium (W3C) at 
http://www.w3.org. 
 
The World Wide Web Consortium is a not-for-profit organization that 
coordinates the evolution of the Web.  It includes the Internet Engineering 
Task Force, the group of people who make recommendations for new 
markup. 
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Head Elements 
 
<HTML> 

<HEAD>  has sub-elements that define header material: 
 

<TITLE> the title of your document is what appears in a web 
browser’s Favorite or Bookmark list. Your document’s title should 
be descriptive as some search engines use the title for indexing. 
</TITLE> 
 
<BASE> can be used to record the document's location in the form 
of a URL. URL is an acronym for Universal Resource Locator.  The 
URL is essentially the address of the web page or site, as in 
http://www.trainingtools.com.  This URL may be used to resolve 
relative URLs located within the document (necessary if the 
document is not accessed in its original location). </BASE> 
 
<ISINDEX> is an older tag that is currently not recommended for 
use in developing your pages in the HTML 4.0 Specification. 
</ISINDEX> 
 
<META> provides information such as the page’s keywords and 
description that appear in HTTP headers. </META> 
 
<SCRIPT> contains either JavaScript or VBScript </SCRIPT> 
 
<STYLE> contains cascading style sheet information </STYLE> 
 
<LINK> forms a relationship to another object on the Web. It can 
be used to link a style sheet or a section of JavaScript. </LINK> 
 

</HEAD> 
 
<BODY>  
   The remaining HTML elements are contained within these tags.  
</BODY> 

</HTML> 
 
 
Base, Meta, Script, Link and Style are covered in detail later in the course in the 
URL and Anchors, Special Elements, VBScript and JavaScript, and Cascading 
Style Sheets chapters respectively. 
 
Note: a framed document is formatted differently than a basic document and is 

discussed in the advanced section of the course. 
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Page Properties 
 
By {Right Clicking} on the document and selecting “Page Properties…” the 
Page Properties Dialog Box enables you to modify a number of the 
<HEAD> elements, and attributes of the <BODY> element.   
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General Tab 
 

 
 
We will discuss some of the other options in later chapters.  For now, you 
can enter the Title of your page in the Title box. 
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Page Properties – Background Tab 
  

By {Clicking} on the Background tab of the Page Properties dialog box you 
set a number of attributes of the <BODY> element. You can change your 
web page’s background, text and link colors and enable a rollover effect 
(where an image or content change when your mouse pointer passes over 
top of a graphic or text.  If you decide to use an image for your document’s 
background, you can also set this property from the Background dialog 
box. 

 

 
 

 
FrontPage Tip  

 
 
If you plan on using an image for your web document’s background, use 
caution! Avoid background images that are distracting to your visitors or 
those that hinder the readability of your web page. As well you want to 
avoid progressive jpegs and large images, as they will increase your web 
page’s download time. 
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Page Properties – Margins Tab  
 

The Margins tab in the Page Properties Dialog Box allows you to set both 
the top and left margins for your web document in pixels. These are 
attributes of the <BODY> element. 

 

 
 
Note: These attributes are only supported by Internet Explorer. 
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Page Properties – Custom Tab  
 
The Custom Tab in the Page Properties Dialog Box displays Meta tags 
(system variables and user-defined variables) of the active page. Meta 
tags supply information about a page, but they do not affect the 
appearance of your web page. In this particular case, the Meta Name 
“Generator” defines that this web document was created using Microsoft 
FrontPage 4.0.  Meta tags are often used by Search Engines to identify 
your page.  Meta “Description” and “Keywords” use is discussed later. 
 
Remember <META> elements appear in the <HEAD> of your document. 
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Page Properties – Language Tab  
 
The Language Tab is used to change the HTML character encoding for 
the page. If you are developing web pages in different languages for 
various countries of the world you will want to modify these settings. 
These put additional <META> tags in the page that the browser will 
understand and display the page properly. 

 

 
 
Note: you will need the different language files installed in your operating 
system to see the page displayed properly. 
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An example HTML document 
 

In the document below you will see a number of the page settings that 
were discussed over the last several pages. We will be examining 
<META>, <TITLE> and <BASE> elements in detail later in Special 
Elements. The attributes of the <BODY> element determine how your 
page will look in general. 

 
<html> 
 
<head> 
<meta http-equiv="Content-Type" content="text/html; charset=windows-
1252"> 
<meta http-equiv="Content-Language" content="en-ca"> 
<meta http-equiv="keywords" content="Cool, cool, nifty, neat, exciting"> 
<meta name="GENERATOR" content="Microsoft FrontPage 4.0"> 
<meta name="ProgId" content="FrontPage.Editor.Document"> 
<title>This is a cool web page</title> 
<base href="http://www.trainingtools.com"> 
</head> 
 
<body background="/Images/teddy.jpg" bgcolor="#000000" text="#FFFF00"  
 link="#FF00FF" vlink="#00FF00" alink="#00FFFF" topmargin="50"  
 leftmargin="50"> 
 
</body> 
 
</html> 
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Inserting Elements  
 
Elements are the components that create the structure of an HTML 
document. Tables, Images, Forms, Applets are just a few of the many 
elements you can have on your page. FrontPage does not refer to these 
components as elements, but rather by the type of element, as in image 
for example; however, it is wise to familiarize yourself with this term for 
future reference. 
 
1. Position your cursor where you want to insert the element. {Click} the 

corresponding icon on one of the toolbars. For example, to insert an 
image in your web page, you would {Click} the  button. However, 
not every element will have a button on the toolbars. 

 
2. Position your cursor where you want to insert the element. From the 

Insert Menu you can choose from a number of different options to 
include on your page. Scroll down the menu items and select the 
appropriate element.  
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Modifying an Element’s Attributes  
 

If you decide to modify the element’s attributes, there are a few ways to 
achieve this: 
 
1. Select the element or content you want to modify and {Right Click} on it 

once. A pop-up menu appears with a number of options. Select the 
option that reads: “{Element} Properties”. FrontPage calls Attributes 
Properties instead of Attributes. 

 

 
 
In this example, you have already inserted a Horizontal Line (covered in 
the next chapter), but you want to change its properties (E.g. Width, 
Height, Color). {Right Clicking} on the Horizontal line causes a pop-up 
menu such as the one above to appear. To edit the Horizontal Line’s 
properties you would choose “Horizontal Line Properties” 
 
2. Another way of modifying an element’s properties is to position your 

cursor on the element and {Click} once. Simultaneously hit the ALT + 
ENTER keys. The edit properties dialog box appears.   

 
 
Removing Elements   
 

1. Select the object you wish to remove and hit the delete key (DEL). 
 

2. Select the object or file you want to remove. From the Edit Menu, scroll 
down and select either “Cut.”  
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Chapter 3 – Exercise 1 
 

The goal of this exercise is to familiarize you with the FrontPage editor 
and the topics discussed in Chapter 2. 
 

Procedure 
 

1. Start FrontPage 2000. 
 

2. To change the Title of your page, {Right Click} on the blank document 
and select  “Page Properties.” In the text field beside “Title,” key in 
{Your Company Name – A Project Name} E.g. XYZ Corp. – Intranet 
Project. {Click} OK. 

 
3. To view the source code produced by Step 2, select the HTML Tab 

located above the status bar. You will be able to see the result of 
setting the document’s title. It should look something like this: 

 

    
 

4. Next, {Click} on the View menu and make sure that all of the available 
Toolbars have a checkmark beside them: Standard, Format, Pictures, 
and Table. (These toolbars are covered throughout the rest of the 
class.) 

 
5. Switch back to Normal View by selecting the Normal tab above the 

status bar. {Right Click} on your page and select “Page Properties” 
{Click} on the “Background” tab and set your document’s background 
color to a shade of light blue. {Click} OK. 

 
Note: If you don’t specify a background color for your documents, 
older browsers will default to a light gray background. Both IE 4, IE 5 
and Netscape 4.x browsers default to your windows desktop 
background. If you want your documents to display properly, it is a 
good idea to set the background color. 
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6. Save your page by {Clicking} on the File menu and choose the Save 
option. Navigate to C:\Fpfiles\exercises\ Name your file index.htm. 

 
7. Preview your work in your web browser by {Clicking} on the Preview in 

Browser  button. This button is located on the Standard toolbar.  
 

Note: The title should be displayed in top of the window and the color of 
page should be set to a light blue. We will add additional elements to the 
body in the next chapter. 
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Review Questions 
 

1. What is an element? 
 
 
 
2. What is an attribute? 

 
 
 

3. What elements should be placed in the <HEAD> of your page? 
 
 
 

4. How do you change the background color of your document? 
 
 
 
5. Name two ways to modify an element’s properties? 
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Summary 
 

As a result of this chapter, you should be able to:  
 

• Describe the Basic Document Structure 
 

• Identify the sub-elements of the <HEAD> element 
 

• Modify the <BODY> element’s attributes through the page properties 
dialog box. 
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4 
 

Headings, Paragraphs and Breaks 
 
 

In this chapter you add headings to your page, insert paragraphs, add line 
breaks and horizontal rules. 

 
Objectives 
 

Upon completing this section, you should be able to:  
 
1. List and describe the different Heading elements 
 
2. Know when paragraphs are created 
 
3. Insert line breaks where necessary 
 
4. Add a Horizontal Rule 
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Headings - <Hx> </Hx>  
  
Inside the BODY element, heading elements H1 through H6 are generally 
used for major divisions of the document. Headings are not mandatory. 
Headings are permitted to appear in any order, but you will obtain the best 
results when your documents are displayed in a browser if you follow 
these guidelines: 
 
• Heading 1 “<H1>” should be used as the highest level of heading, 

Heading 2 “<H2>” as the next highest, and so forth. 
•  You should not skip heading levels: e.g., an H3 should not appear after 

an H1, unless there is an H2 between them. 
 
The size of the text varies from very large in an <H1> heading tag to very 
small in an <H6> tag.  You could use the Size attribute of the FONT 
element to change the size of your type or characters, however, the 
Headings elements offer pre-determined sizes and take less code than 
using FONT SIZE=”x”. 

 
Headings can be inserted by selecting the desired size with the Style 
drop-down menu:                            
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Paragraph - <P> </P>  
 
Paragraphs allow you to add text to a document in such a way that it 
automatically inserts a space above the text and adjusts the end of the 
line to suit the window size of the browser in which it is being displayed. 
Each line of text stretches across the entire length of the window. 
 
Each time you press [ENTER] on your keyboard a new paragraph will 
start. 
 
Paragraph tags are automatically placed around the text you type. For 
example any text you type is surrounded by <P> and </P> tags when 
viewed in HTML view. 
 
 

Paragraph Properties  
 

The Paragraph Properties dialog box is available when you {Right Click} 
inside a paragraph and select “Paragraph Properties…” from the pop-up 
window. You can choose the paragraph alignment, indentation and the 
line spacing.  FrontPage also displays a preview of your selected options. 
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Note: Using the Indentation and Spacing settings will add what is called 
inline style information. Browsers other than Internet Explorer 4 and above 
may not interpret these settings properly, we recommend testing your 
pages in multiple browsers in order to guarantee they look the way you 
expect them to. Inline Styles are covered in detail in the chapter on 
Cascading Style Sheets.  
 
 

FrontPage Tip 
 

 
Browsers ignore multiple spaces between paragraphs, within paragraphs 
and within tables.  If you use multiple spaces between words and insert 
multiple empty paragraphs, FrontPage is actually inserting a non-visible 
character known in HTML as an NBSP (non-breaking space). When you 
switch views from Normal to HTML, you will notice that the special 
character for a space is &nbsp;  
 
For Example: 
<P>There are two&nbsp;&nbsp;spaces between “two” and “spaces”.</P> 
 
Special Characters like the non-breaking space are covered in the next 
chapter. 
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Break - <BR></BR>  
 
Line breaks allow you to decide where the text will break on a line or 
continue to the end of the browser window. There may be instances where 
you want the text to appear on the next line. Example: a return address 
contained in one Paragraph but on multiple lines or text in a Header, such 
as a title for the document. 
 
You can insert a forced Line Break or BR from the Insert Menu or by using 
Shift Enter. The Shift Enter key combination will not bring up the Break 
Properties. 
 

 
 

 
 
 

 
  

A <BR> is an Empty Element. Empty Elements may have properties but 
do not contain content. 
 
The Break Properties dialog box also enables you to assign properties to 
a line break.  The Clear attribute can be used to force a line down; if an 
image is located at the page’s left margin, the clear attribute will move the 
cursor down to the first line that is cleared at the left margin. The same 
applies with the option of clearing the right margin.  If an image is at the 
left or right margins, the clear both margins attribute will force a line break 
until both margins are cleared. 
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Horizontal Rule - <HR>  
 

The <HR> element causes the browser to display a horizontal line (rule) in 
your document. 
To insert a Horizontal Rule, {Click} on the Insert Menu and then {Click} on 
the “Horizontal Line.” 
The Horizontal Rule’s properties can be modified by either {Right-Clicking} 
on the line or by {Double Clicking} it.  

 

 
 

 
 
WIDTH:  
Width of the rule in pixels or percentage of screen width. 
 
HEIGHT:  
Height of the rule in pixels. 
 
ALIGN:  
Aligns the line (Left, Center, Right). 
 
COLOR:   
Sets a color for the rule (Applies to IE 3.0+). 
 
NOSHADE:  
Whether the rule should have a 3D or flat look. 
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HTML View: 

 
 
Normal View: 
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Chapter 4 – Exercise 1 - Headings 
 

In FrontPage using the file created in the previous chapter add the 
following elements to your web page: 

 
Procedure 
 

1. Add an H1 to your page. Key in {Your Company Name}. 
 

2. Add an H2 after the H1 on your page. Key in {Your Division or Dept. 
Name.} 

 
3. Add an H3 after the H2 on your page. Key in {A Project Name} E.g. 

Intranet Project. 
 

4. Add an H4 after the H3 on your page. Key in {Project Name} Plan. 
 

Once you have completed steps 1 – 4, switch from Normal View to HTML 
View and do the following: 

 
5. Add an H3 after the H4 on your page. Key in {A different Project 

Name} E.g. Internet Project. 
 

6. Add an H4 after the H3 on your page. Key in {Project B Name} Plan. 
 

7. Your document should look something like this in the HTML view at 
this point: 
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Chapter 4 – Exercise 2 – Horizontal Rules 
 

In FrontPage do the following: 
 

1. Add a Horizontal Rule after the H1 and before the H2. 
 

2. Set the Horizontal Rule’s properties to be only 50% of the width of the 
screen and its alignment as left justified. (Remember elements have 
properties.) 

 
3. Add a Horizontal Rule after the first H4 on the page. (Leave the rule at 

its last default settings.) 
 

Switch to HTML View after you have completed Steps 1 –3:  
  

4. Your document should look similar to this now 
 

 
 

Note: The settings for the second horizontal rule default to the last 
settings applied. You can change the rule’s properties by {Right Clicking} 
on it.  
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Chapter 4 – Exercise 3 – Paragraphs & Breaks 
 

1. In Normal View, Insert a Paragraph between each one of the 
Headings.  

 
2. Add a <BR> in the first paragraph you created so that your page 

looks similar to the example below. 
 

3. In HTML View, scroll to each paragraph you inserted and notice 
that between the paragraph tags there is a &nbsp; FrontPage 
automatically inserts a &nbsp; if you are working in Normal View 
and do not enter anything in the paragraph. 

 
Note: If you add paragraph tags in HTML View and switch to Normal 
View, FrontPage will delete an empty paragraph unless you add a 
NBSP or another entity. 
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Review Questions 
 

1. How do browsers handle multiple spaces? 
 
 
 
2. What is one way to start a new paragraph? 
 
 
 
3. How many Headings are there? 
 
 
 
4. When would you use a Break? 
 
 
 
5. How would you insert an HR that is centered and half a page long? 
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Summary  
 

As a result of this chapter, you should be able to:  
 
• List and describe the different Heading elements 
 
• Know when paragraphs are created 
 
• Insert line breaks where necessary 
 
• Add a Horizontal Rule 
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5 
 

Character Formatting 
 
 
 

In this chapter you will learn to enhance your text with Bold, Italics, and 
other character formatting options. 
 

 
 
Objectives 
 
 

Upon completing this section, you should be able to:  
 
1. Change the color and size of your text 
 
2. Use the Format Toolbar to change the appearance of text 
 
3. Align your text 
 
4. Add special characters 

 
5. Use other character formatting elements 
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 Character Formatting 
 
Enhancements to your text can be made by {Clicking} on selections from 
the Format Toolbar: 
 
Formatting Toolbar: 

 
 

Style 
Select from the “Style” drop-down list to apply Block elements such as 
Headings, which we used in the last chapter. We will be discussing 
Address blocks in this chapter and Lists in the next chapter. 
 
Font 
Select from the “Font” drop-down list to change the font face from the 
browser default.  Try to use fonts that users usually have on their 
computers.  If users viewing your page do not have the specified font the 
look or layout of your page may be significantly different. 
 
Font Size 
Select from the “Font Size” drop-down list to modify the size of your text.  
The default browser size is 3. 

 

•   <B>Bold </B> 
 

•   <I> Italic  </I> 
 

•   <U> Underline </U> (Not recommended as links are underlined. 
Use this formatting option sparingly!)  

 
•  <SPAN STYLE=background color: #00FF00> Text can be 

highlighted with the Highlight text icon. </SPAN> Highlighted text 
requires a 4.0 browser or higher to view. 

 

•  Color is modified with the Set Font Color icon.  
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Note: The arrow at the end of the Background Color button and the Font 
Color button produce a drop down menu of colors. See below: 
 

 
 
 
Character Formatting Examples: 

 
The following are examples of the different character formatting options in 
Preview Mode: 
 

          
 

If you were to switch to the HTML View mode, the character formatting 
would look like this: 

 

 
 
 
FrontPage Tip  
 

 
Using different colors for your text is a good idea for emphasizing 
keynotes; however, keep in mind that too many colors can be distracting 
to your visitors. Font colors should also be consistent throughout your web 
site.  
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Font Properties 
 
You can achieve the same effects by {Clicking} on the Format Menu and 
selecting the Font option.  

 

 
 

Another means of modifying text is to highlight the text and {Right Click} 
on the selection. A pop-up menu appears with various selections. Select 
“Font...” or use the indicated keyboard shortcut by holding down the Alt 
key and pressing the Enter key on your keyboard.  
 

 
 
The Font Dialog Properties box appears: 
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You can specify the font, the font style (bold, Italics, etc.) and size. The 
“Effects” section provides extra options for enhancing type such as: 
“Underline”, “Strikethrough”, “Over line”, “Blink”, and more. These will be 
discussed shortly.  

  
 
The <FONT> Element 
 

The <FONT> Element has a number of attributes that are set by the “Font 
Properties” dialog box. The attributes are: 
 
FACE:  
Short for typeface indicates the font you want the text displayed in.  
 
SIZE:  
Indicates the size of the text, the default is 3. 
 
COLOR:  
The default is black. Color is information represented as Red, Green and 
Blue (RGB) values. These values are from 0 to 255 represented in 
hexadecimal format.  
 
For Example: 
 
<font face="Arial" size="4" color="#FF0000">Large RED</font>
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Changing text color  
 
{Click} on the down arrow to the right of “Color” to produce the following 
dropdown list. 
 

  
 
You can customize font colors by selecting “More Colors…” at the end of 
the drop down menu. 
 
 

 
 
The More Colors box appears displaying a hexagon of standard colors. 
The button labeled “Custom….” allows you to define a color. 
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Once you have chosen a color you like, {Click} the button “Add to Custom 
Colors” and it will be saved for future use. 
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Additional Character Formatting Effects 
 

The following formatting elements can be accessed through the Font 
Properties Dialog box. To change the font’s properties, highlight the area 
of text and {Right Click}. Select “Font” and {Click} on the appropriate effect 
you wish to apply.  

 
<STRIKE> strike-through text style </STRIKE> 
<BLINK> this text will be blinking </BLINK> 
<SUP> places text in superscript style </SUP> 
<SUB> places text in subscript style </SUB> 
 

 
 
HTML View: 

 
 
Normal View: 

 
 
Note: Overline uses what is called an inline style attached to the <SPAN> 
element.  Both of these concepts are discussed later in Cascading Style 
Sheets.  At present we do not recommend you use this feature until you 
understand Cascading Style Sheets. Blink is not supported by Internet 
Explorer. 
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Additional Character Formatting Effects 
 

Note: Small caps, All caps, Capitalize, and Hidden use what is called an 
inline style attached to the <SPAN> element both of these concepts are 
discussed later in Cascading Style Sheets. 
 
<STRONG> Used where text needs to be expressed a little stronger than 
normal </STRONG>  The effect is similar to Bolding text with the <B> 
</B> elements. 
<EM> Used to add emphasis to a piece of text </EM>  The effect is similar 
to Italicizing text with the <I> </I> elements. 
 
 

 
 
HTML View: 

 
 
Normal View: 
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Character Formatting - Technical Documentation  
 

These special formatting elements are used for technical documentation 
applications: 
 
<SAMP> used for sample output from programs, scripts, etc. </SAMP> 
<DFN> defining instance of the enclosed term </DFN> 
<CITE> Citation: the act of citing, or quoting <CITE> 
<VAR> used for variables or arguments to commands </VAR> 
<KBD> used for text to be typed by the user </KBD> 
<CODE> used for extracts of program code </CODE> 
 

 
 
HTML View: 

 
 
Normal View: 
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<BASEFONT> 
Used to set the base font size for the web page. The size attribute is an 
numerical value ranging from 1 to 7 (3 is the default).  The base font 
applies to the normal and preformatted text but not to headings, except 
where these are modified using the FONT element with a relative font 
size. 
 
NOTE: FrontPage does not have a button or dialog box that offers this 
option; you will have to edit this tag by switching to HTML View.  There is 
no <BASEFONT> end tag. 
 
 

<BLOCKQUOTE>  
This element is used to create block or indented text, usually quotations. It 
is usually indented from both margins by the browsers.  You can add 
these tags with the Increase Indent, and remove them with the Decrease 

Indent button .  
</BLOCKQUOTE> 
 

 
HTML View: 

 
 
Results in Preview: 

 
  

 
NOTE: In this example, the <BLOCKQUOTE> tags were used three 
times. This caused the text selection to be indented more than if you were 
to indent the selection once. 
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<ADDRESS>  
The address element specifies information such as authorship and contact 
details for the current document.  Select the text that describes your 
address and use the Style drop down list to select and apply the address 
element.   The address element italicizes your text and eliminates spacing 
above and below the text. 

</ADDRESS> 
 

 
 
HTML View: 

 
 
Results in Preview: 

 
 



 
 

Learn Web Development in a classroom @  http://www.xnu.com Call 1-416-675-1881 59 
 

Special Characters  
 

Using the Insert Menu and selecting the Symbol Option, you can insert 
special Characters not found on the average keyboard. 
 

 
 
A Window containing the available Characters appears.  
 

 
 
{Double-Click} on a character to insert it. Dismiss the Special Character 
palette by {Clicking} on the Close button. 
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Alignment  
 

FrontPage arbitrarily determines the best way to achieve alignment. 
Headings, Paragraphs, Images, ActiveX Objects, JAVA Applets and 
Tables all have properties for alignment (ALIGN).  
 
You can change the alignment of an element in FrontPage by {Clicking} 
on the element you want to align and pressing one of the three alignment 
buttons on the Format toolbar. Alignment usually means LEFT , 
RIGHT , and CENTER  but, it may also refer to TOP, BOTTOM, 
MIDDLE etc. depending on the element you have selected.  
 
If the element you want to align is an image, you can change its alignment 
by {Right Clicking} on the image once and selecting “Picture Properties.” 
Not all elements have the alignment options of TOP, BOTTOM and 
MIDDLE etc.  
 
Proper positioning of all of the components in a web page can be 
achieved by using other elements to control alignment: 
 
• <DIV ALIGN=”value”></DIV> Represents a division in the document 

and can contain most other element types. The alignment attribute of 
the DIV element is well supported. 

• <CENTER></CENTER> Will center all the elements it contains. 
• <TD></TD> and <TH></TH> also support the align attribute so that 

you can align the contents of a table cell. 
 
Note: the following elements will be used later in the course: DIV, TD and 
TH. 
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Chapter 5 – Exercise 1 
 

1. Below the bottom Horizontal Rule, add © XYZ Corporation. 
 

2. At the end of the line you just added, Superscript a small TM at the end 
of the Company Name. 

 
3. After the information you just added, add an address element and 

enter in your company’s address. 
 

4. Switch to HTML View. Your document should look similar to the 
following: 
 

 
 

5. Save your work and then Preview your page in your web browser. 
Your work should look similar to the following: 
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Chapter 5 – Exercise 2 
 

1. Add a Blockquote under each H3 and create a brief description about 
the project. 

 
2. Change the color of the text in the block quote to blue. 

 
3. Decrease the size of the text in the block quote.  

 
 

4. Switch to HTML View. Your document should look similar to this: 
 

 
 

5. Switch back to Normal View. Your document should look similar to this: 
 

 
 
 
Chapter 5 – Optional Exercise 
 

1. Add some text about the Division or Department in the Paragraph 
below the H2, and try some of the other character formatting elements. 

 
2. Center the H1 - Company Name in the center of the page. 
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Review Questions 
 

1. What are six character-formatting elements? 
 
 
 
2. What are the two ways you can center text? 
 
 
 
3. How would you add the copyright symbol to a page? 
 

 
 

4. What are the steps required to change the color of your text? 
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Summary 
 

As a result of this chapter, you should be able to:  
 
• Change the color and size of your text 
 
• Use the Format toolbar to change the appearance of your text 
 
• Align your text 
 
• Add special characters 
 
• Use additional character formatting elements 
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6 
 

Lists 
 
 
 

In this chapter you learn how to create a variety of standard HTML lists. 
 
 
Objectives 
 

Upon completing this section, you should be able to:  
 
1. Create an unordered list 
 
2. Create an ordered list 
 
3. Create a definition list 
 
4. Create other lists 

 
5. Nest Lists 
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List Elements 
 

HTML supplies five list elements. List elements are composed of one or 
more LI (list item) elements. Most of the list elements are contained within 
an open and closing list tag. 

 
 
Bulleted / Unordered List <UL></UL> 

 
Items in this list start with a list mark such as a bullet. Most browsers will 
change the list mark in nested lists (Netscape, IE 4.x). To start using this 
option {Click} on the Bulleted List button , the button will change to 

. 
 
HTML View: 

 
 
Normal View: 

 
 
To end the Bulleted List {Click} off the Bulleted List button. 
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List Properties - Plain Bullets 
 

You also have the choice of three bullet types: Disc (default), Circle, 
Square.  
 
To change the list properties {Right Click} on your list.  Select “List 
Properties” from the pop up menu. {Click} on the “Plain Bullets” tab and 
choose from one of the four options. Your selection will set the TYPE 
attribute of the UL element.  
 

 
 
NOTE: Changing the bullet type is not supported in Internet Explorer 3.0 
or below. 
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Numbered / Ordered List <OL></OL> 
 
Items in this list are sequenced automatically by the browser. The 
sequence indicator can be varied to reflect nesting levels. To start using 
this option {Click} on the Numbered List button , the button will change 

to  reflect the list’s active status. 
 
HTML View: 

 
 
Normal View: 

 
 
To end the Numbered List {Click} off the Numbered List button. 
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List Properties - Numbers 
 

The List Properties Dialog Box is accessed by {Right Clicking} on the list 
and selecting “List Properties.” {Click} on the “Numbers” tab and select 
one of the five numbering schemes available. Your selection will change 
the settings of the TYPE attribute for the list. 

 

 
 

 
You can also specify a starting number for an ordered list. The value of 
the START Attribute is always an Arabic number (1,2,3,4…). Changing the 
starting number is useful in a situation where your list items are separated 
by an image, unrelated text or a nested list. 
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The following is an example of a Numbered List: 
 

HTML View: 

 
 
Normal View: 
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List Properties - Other Lists 
 

 
 
Formatting Toolbar: 

 
 

 
 
The other lists are inserted from the “Style” menu on the Formatting 
Toolbar or from the “List Style:” on the Other tab of the List Properties 
dialog box. {Click} on the drop-down list on the Toolbar and select the 
desired item from the menu.  
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<DL> - Definition List 
 
A Definition List is different than the lists discussed previously. Each 'item' 
in a DL consists of one or more Definition Terms (DT elements) followed 
by one or more Definition Descriptions (DD elements).  
 
To create a Definition List, {Click} on the Change Style drop down menu 
on the Format Toolbar and select “Defined Term.” Type the Definition 
Term and press the Enter Key. Notice how the next line is indented for the 
Definition Description to emphasize the relationship between the term and 
description. 
 
 
HTML View: 

 
 

 
Normal View: 

 
 
COMPACT:  
The definition list type also has a 'compact' attribute. When this attribute is 
set less white space is displayed in the browser. 
 
HTML View: 
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<DIR> - Directory List 
 

Directory list is a special unordered list. Each LI element in this kind of list 
should be no longer than 24 characters. 

 
 
<MENU> - Menu List  
 

Menu list is another unordered list. Each LI element in this kind of list 
should be no longer than one line. 

 
Note: The exact formatting of Directory and Menu lists will vary depending 
on the Web browser used. Most current browsers do not support these 
lists. 

 
 
FrontPage Tip 
 

 
To change from a Bulleted / Unordered List to a Numbered / Ordered List, 
place your cursor in the list. {Click} on the Numbered / Ordered List button 

. You can change it back to an Unordered List by {Clicking} on the 
Bulleted / Unordered List button . 
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Nesting Lists  
 

To create a nested list (a list within a list): 
 
1. In FrontPage, place the cursor at the end of the item in the primary list 

that precedes the line where you want the nested list to begin. 
 
2. Press ENTER to create a new line. 

 
3. {Click} the Increase Indent button twice on the Format toolbar. 

 
4. Type the first list item to be added, then {Click} the Numbered List or 

Bulleted List button on the Format toolbar if you want to change the list 
type for the nested list. 

 
5. Press ENTER for each additional line item you want to add to the 

secondary list. 
 

6. To add more items after the primary list level use the decrease indent 
button until the list item is at the correct level. 

 
HTML View: 

 
 

Normal View: 
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List Properties - Picture Bullets 
 
Images can also be used as bullets, however this inserts HTML code 
involving Image and Table elements that have yet to be discussed. 
Images are covered in Chapter 6 and Tables are covered in Chapter 8.  
We do not recommend you experiment with this option at this time. 
 

 
 
If you place a check in the box labeled “Enable Collapsible Outline”, users 
browsing your web site will be able to collapse or expand an outline list. 
This will affect all list items at the current list level and all sub-levels below.  
 
Enabling this feature will result in FrontPage inserting a fragment of code 
called “JavaScript.” This topic will be covered in Day 2 of the FrontPage 
Courseware. 
 
Note: Collapsible outlines can only be viewed in 4.0 or higher browsers 
such as Microsoft Internet Explorer 4.0 or Netscape Navigator 4.0. 
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Chapter 6 – Exercise 1  
 

1. Add an Ordered List below your first Project Plan Heading. 
 

2. Enter two or three list items. 
 

3. Nest another Ordered List below the second item in the first list. 
 

4. Change the numbering scheme to lower case roman numerals for the 
nested list. 

 
5. Add two items. 

 
6. Add a paragraph after your list with some text. 

 
7. Insert another ordered list after your paragraph, and start numbering 

were your first list left off. 
 

8. Switch from Normal View to HTML View. Your work should look similar 
to this: 
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9. Save and Preview your work. Your page should look something like 
this: 

 
 

 
 

 
 
Chapter 6 – Optional Exercises 
 

1. Create another list this time under the second Project Plan. 
 

2. Try switching between Ordered Lists and Unordered Lists. 
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Review Questions 
 

1. Can you nest lists? 
 
 
 
2. When would you use an ordered list over an unordered list? 
 
 
 
3. Why would you use a definition list? 

 
 
 

4. What other lists are available? 
 
 
 

5. How can you change the type of list you originally selected? 
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Summary  
 

As a result of this chapter, you should be able to:  
 
• Create an unordered list 
 
• Create an ordered list 
 
• Create a definition list 
 
• Create other lists 
 
• Nest your lists 
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7 
 

Anchors and URLs 
 
 
 

In this chapter you learn about Uniform Resource Locators and how to 
add them as Anchors or Links inside your web pages. 

 
Objectives 

 
Upon completing this section, you should be able to:  
 
1. Insert links into documents 
 
2. Define Link Types 

 
3. Define URL 
 
4. List some commonly used URLs 

 
5. Set Link Colors 

 
6. Create an Image Map using FrontPage’s Mapping Tools 
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Link Elements 
 

Most HTML documents contain links to other documents located on the 
Internet. These links are defined by URLs (Uniform Resource Locators), 
which provide the location and filename of a document and the method 
used to access it. 
 
The following elements represent links to other documents: 
 
<A HREF=””> </A>: Create or Edit a Hyperlink . The <A></A> 
element is called an “anchor.” The HREF attribute of the anchor element 
specifies a URL. If this attribute has a value, the contents of the <A></A> 
element will be highlighted when the document is displayed in a browser. 
{Clicking} on the highlighted content will cause the browser to attempt to 
open the file specified by the URL. 
 
HTML View: 

 
 

Normal View: 

 
 

In this example, the highlighted text “Microsoft’s Homepage” represents 
the link to the file named as the value of the HREF. In this case, the value 
of the HREF links to Microsoft’s homepage. 
 
 

Link Types 
 

There are three major types of links: 
 

Internal Links   
Are links within a document. They help in the navigation of large 
documents. 
 
Local Links   
Are links to documents on the local web server. Local links can be the full 
(absolute) URLs (E.g. http://www.yourdomain.com/sales/report.htm) or a 
partial (relative) URL related to your current directory (E.g. 
/sales/report.htm). 
 
External Links   
Links to pages on other web servers.  External links are always the full 
URL. 
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Creating Internal Links  
 
An Internal Link or  “Bookmark” is a named location on a page that is the 
target of a hyperlink. In the URL, a bookmark is preceded by a number 
sign character (#).  
 
To create a “Bookmark” follow these steps: 
 
1. Select text in the document you would like to create a link to. Locate 

the “Edit” menu and select the option “Bookmark.” 
 

 
 

2. In the Bookmark Name field of the dialog box that appears, enter the 
name of the bookmark, or accept the name that FrontPage suggests. 
You can include spaces in the bookmark name, however spaces in the 
name are not standard HTML practice. 

 
3. {Click} OK when you have chosen a name.  FrontPage places a dotted 

underline beneath the text to indicate a Bookmark has been applied. 
 

4. Next select the text that you would like to create as a link to the 
bookmark. Go to the Insert Menu and select “Hyperlink” from the list of 
options. 
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5. In the dropdown menu list, locate the name of the Bookmark you want 

to link too. Once you have chosen the Bookmark Name, {Click} the OK 
button. 

 
6. Switch from Normal View to HTML View. The code will be similar to the 

following: 
 
 
HTML View: 

 
 

When you {Click} on the HREF hyperlink, your browser will jump to the 
bookmark created in Step 2. 
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Creating Local Links  
 

Local or relative links are hyperlinks to documents on the same web 
server. This type of link can be created easily from the Hyperlink Dialog 
Box. 
 
1. Highlight the text that you would like to act as the link to the new 

document.  
 

2. {Click} on the “Insert” menu and choose Hyperlink, or locate the 
Hyperlink button  on the Standard Toolbar.  

 
3. From the Hyperlink Dialog box, locate the document to link to by 

{Clicking} on the file  button. Select the document and {Click} OK.  
 

4. Switch from Normal View to HTML View. The code should look similar 
to the following: 

 
 
 

HTML View: 
 

 
 
Normal View: 
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Creating A Link to A New Page  
 
1. FrontPage gives you the option of creating a new page and adding a 

link from the current page simultaneously.  
 

2. Highlight the text you would like to act as the link to the new page.  
 

3. {Click} on the Hyperlink  button and locate the New Page  
button. 

 
4. The New Page Dialog box appears prompting you to choose the 

document template. Select the template and {Click} OK. 
 
 
Creating External Links  

 
External Links are created by {Clicking} on the Hyperlink  button on the 
Standard Toolbar. If you know the URL of the document you want to link 
to, type it into the URL text field. Or, an easy method of creating an 
external link is to {Click} on the  button to open your browser window. 
This method will allow you to search the Internet to locate the file you want 
to link to. 
 
  

  
If you are planning to include External Links on your web pages, a 
safe practice is to send an email to the site’s owner asking 
permission to link to their web site. You may also want to ask 
whether they would be willing to exchange reciprocal links. 
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URLs - Uniform Resource Locators 
  
A URL is a standard way of referencing a Service or protocol, a Host 
name, a Port, and a Directory-path. 
 
Service :// Host name : Port / Directory-path 
 
E.g. http://www.xnu.com:80/default.htm 
 
Not all of these components appear in each URL, as you will see when 
you learn about the different types of URLs for different protocols. But the 
preceding example is a good general guide. 
 
 

HTTP – HyperText Transport Protocol 
 

This is used to link your HTML pages to HTML pages on your site, or to 
pages on other sites around the Internet. 
E.g. http://www.xnu.com/default.htm 
 
• The type of protocol is identified as http. 
• The Host name is www, in the domain 1stvirtual, in the zone com 

(which identifies it as a commercial site.) 
• default.htm is the actual web page. 

 
 
FTP – File Transfer Protocol 
 

The FTP protocol is used to download files from a FTP server to the 
surfer’s computer. 
E.g. ftp://ftp.xnu.com/prizes/brkbrk.wav 
 
• The type of protocol is identified as ftp. 
• The Host name is ftp.1stvirtual.com. 
• The subdirectory is prizes. 
• The file is brkbrk.wav 
 

News– News Groups  
 

Newsgroups or discussion groups are places for people to post 
messages, and read other peoples messages. 
E.g. news:alt.internet.services 
 
• The type of service is identified as news, for the Usenet newsgroup 

service. 
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• The newsgroup is alt.internet.services.  
This will invoke a client’s news reader program. 

 
Gopher  
 

Gopher was a predecessor of HTML and HTTP, it is rarely used today as 
it is to much work to maintain. 
E.g. gopher://owl.trc.purdue.edu/ 
 
• The type of service is identified as gopher (a predecessor to the World 

Wide Web.) 
• The Host name is owl.trc.perdue.edu. 

 
 
E-mail – Electronic Mail  
 

This URL will launch the surfers e-mail software and populate the “To:” 
field with the e-mail address specified. 
E.g. mailto:webmaster@1stvirtual.com 
 
• The type of service is identified as the mail client program. 
• The recipient of the message is webmaster@1stvirtual.com. 
 

 
Telnet – Remote Terminal Emulation 
  

This URL will launch the terminal emulation program called telnet on the 
surfer’s computer. 
E.g. telnet://media.mit.edu 
 
• The type of service is identified as the telnet client program. 
• The Host name is media.mit.edu. 
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Specifying Link Colors   
 
The colors of the links are set through the File menu > Properties > 
Background tab … and choosing the appropriate color. 

 

 
 
The following is the raw HTML produced from the work above. Since the 
colors are set in the <BODY> tag they apply to all links in the document. 
 

 
 

Note: Be careful in choosing appropriate link colors for your web 
documents. Most of your visitors will be used to the default link colors: 
Dark Blue (Hyperlink), Purple (Visited Hyperlink) and Red (Active 
Hyperlink). Also, many users set their browsers to override your chosen 
link colors with their own choices. 
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Chapter 7 – Exercise 1 
 

1. In FrontPage create a new document. Choose your document’s page 
title, background color, link colors etc. 

 
2. Using the address element, type your company’s address. Below the 

address element, add the following e-mail address: 
webmaster@xyzcorp.com 

 
3. Highlight the e-mail address and {Click} on the Link button.  

 
 

4. In the Create Hyperlink dialog box, {Click} on the button that creates a 
hyperlink to an email address.  

 
5. Center the hyperlink and save your work. 
 
 

Chapter 7 – Exercise 2 
 

1. Within your existing document, go to a new line and enter your 
company’s name.  

2. Highlight the text and {Click} on the Link button.  
 

3. In the Create Hyperlink dialog box, locate the text field labeled “URL” 
and type in your company’s homepage address after http:// 

 
4. Center the hyperlink and save your work. 

 
5. Preview your work in a browser and {Click} on the link to your 

company’s homepage.  
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Review Questions 
 

1. What are the components of a URL? 
 
 
 
2. What protocols are supported by URLs? 
 
 
 
3. What is the difference between an internal and external link? 
 
 
 
4. What is the difference between absolute and relative URLs? 
 
 
 
5. How do you set the link colors of a web page? 
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Summary  
 

As a result of this chapter, you should be able to:  
 
• Insert links into documents 
 
• Define Link Types  
 
• Define URL 
 
• List some commonly used URL types 
 
• Set Link Colors 
 
• Create Image Maps using FrontPage’s Mapping Tools 
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8 
 

Images and Image Maps 
 
 
 

In this chapter you learn about images and how to place images in your 
pages. 

 
Objectives 

 
Upon completing this section, you should be able to:  

 
1. Distinguish between supported graphics formats and unsupported 

graphics formats 
 
2. Determine which graphic format for the type of image 
 
3. Add images to your pages 
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Supported Image Formats 
 
 
GIF  

Graphic Interchange Format uses a maximum of 256 colors, and uses 
combinations of these to simulate colors beyond that range. The GIF 
format is best for displaying images such as logos, icons, buttons and 
other images with uniform colors and tones.  
 
GIF images come in two different versions and have some extra 
functionality that JPEGs do not. You can save GIF images in GIF 87 or 
GIF 89a format. GIF 89a has the following features that GIF 87 and JPEG 
files do not: 

 
Interlacing 
If you save a GIF 89a image as interlaced, the browser will be able to 
display the image as it loads, gradually getting crisper and clearer until it 
has loaded. Interlaced GIFs have slightly larger file sizes than non-
interlaced GIFs, so you will have to decide whether the interlacing effect is 
worth the extra download time for your images.  
 
Transparency  
With GIF 89a format images you can set a single color to be transparent, 
that is, it will allow the background color or image to show through it. 
Transparency is most commonly used to make the rectangular 
background canvas of an image invisible; this feature can be very effective 
in web page design. 
  
Animated GIFs  
GIF 89a images can also be animated using special software. Animated 
GIF images are simply a number of GIF images saved into a single file 
and looped. Netscape Navigator and Microsoft Internet Explorer both 
display animated GIFs, but many other browsers cannot, and may not be 
able to display even the first image in the loop.  Animated GIFs also take 
longer to download, therefore use animated GIFs with caution.  
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JPG, JPEG 
  

Joint Photographic Expert Group is the best format for photographs 
because JPEG files contain millions of colors. 
 
JPEG images don't give you the option of including transparency or of 
interlacing images, but they do allow you to specify the degree of file 
compression so that you can create a balance between image quality and 
file size. 
 
A new addition to the JPEG format is Progressive JPEG. Progressive 
JPEGs boast superior compression to regular JPEGs. They also give you 
a wider range of quality settings, and support interlacing. 

 
 
Limited Support or Non-Supported Image Formats 
 

Some browsers support the following image formats, however, 
incorporating these file types in your HTML pages is not recommended as 
not all browsers currently support them. You should first convert them to a 
supported format using a graphics editor. 

 
PNG 
Portable Network Graphics is good for combinations of text and graphics 
within one image. PNG permits true color images, variable transparency, 
platform-independent display, and a fast 2D interlacing scheme. PNG 
images are currently only supported by Internet Explorer. 
 
BMP 
MS Windows bitmap 
 
TIFF 
Tagged Image File Format 
 
PCX 
Originally developed by ZSOFT for its PC Paintbrush program, PCX is a 
graphics file format for graphics programs running on PCs.  



 

96 XtraNet U – The place to learn how to develop for the web – http://www.xnu.com 
 

Inserting Images 
 

The image element <IMG> defines a graphic image on a web page. Be 
aware that some browsers may not be able to display images or the user 
has chosen to disable images. In that case the description you include in 
the ALT attribute will be shown.  

 
 
How to Insert Images 

 
FrontPage 2000 provides you with two different ways to insert images: 

 
1. On the Standard Toolbar, {Click} on the image  button. The Image 

Properties Dialog Box will appear. 
  
2. Locate the “Insert” Menu and scroll to the option, “Picture.” 

 

 



 
 

Learn Web Development in a classroom @  http://www.xnu.com Call 1-416-675-1881 97 
 

The Image Dialog Box provides you with several means of obtaining 
images. By {Clicking} on the folder  icon, you can find images within 
directories on your computer.  {Click} on the icon with the globe  to 
search for images on the Internet.  
 
To acquire a scanned image {Click} on the “Scan” button.  To insert Clip 
Art from the Microsoft Clip Art Gallery {Click} on the “Clip Art” button. 
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Image/Picture Properties  
 

To edit an image’s attributes or “properties,” select the image, {Right Click} 
on the image and choose “Picture Properties” from the pop up menu. 
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Picture Properties - General  
 

 
 

SRC - Picture Source:  
This is the path information or URL that describes the location of the 
image file.  
E.g. http://www.whatever.com/images/graphic.gif  or  /images/graphic.gif 

  
ALT - Alternate Text: 
This is a text field that describes an image or acts as a label. It is 
displayed when people turn the graphics off in their browsers, or when 
they position the cursor over a graphic (now supported in most browsers). 
It is also required as an accessibility feature as users with impaired vision 
may not be able to see your graphics. 
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Picture Properties - Appearance  
 

 
 

BORDER – Border thickness:  
Border around the image, specified in number of pixels. If you use an 
image in an anchor you will want to set the border value to zero so that it 
is not outlined. 
 
HSPACE – Horizontal Spacing:   
Horizontal Space on both sides of the image specified in pixels. A setting 
of 5 will put five pixels of transparent space on both sides of the image. 
 
VSPACE – Vertical Spacing:  
Vertical Space on the top and bottom of the image, again specified in 
pixels. A setting of 5 will put five pixels of transparent space on both sides 
of the image. 

 
ALIGN - Alignment:  
This allows you to align the image on your page. The options include: 
Bottom, Middle, Top, Left, Right, TextTop, ABSMiddle, Baseline and 
ABSBottom. 

 
WIDTH - Width:  
Is the width of the image in pixels. This is filled in when you select the 
image to place on the page. 
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HEIGHT - Height:  
Is the height of the image in pixels. This is filled in when you select the 
image to place on the page.  

 
 
Inserting Images with Clip Gallery   

 
To insert an image using Microsoft Clip Gallery, {Click} on the Insert Menu 
and choose the “Picture/Clip Art….” option. 

 

 
 
Select one of the image categories by {Clicking} the category icons. 
 
Once you have selected a main category you are presented with a 
thumbnail view of all the images in that category.  For example under 
Academic you are presented with thumbnail views of Books, Activities, 
Graduations and Drop Cap Letter. 
 
Once you have found the image you are looking for, you simply {Click) on 
it and are given four options such as insert clip, Preview Clip, Add Clip to 
Favorite and Find Similar Clip. 
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FrontPage 2000 also enables you to import images from other resources 
as well as their own online clipart gallery.  To access the FrontPage online 

gallery {Click} on the clips online icon . 
 
 
FrontPage Tips 
 

 
• Try to keep your image file sizes small.  
• Don't rely exclusively on images to convey your information. 
• Use alternate text for images.  
• Don't use background images that make it difficult to read text.  
 
 

 
Using Images as Links 
  

Now that you have added images to your pages, you can turn them into 
links either internal or external by placing them inside the anchor element.  
 
1. {Click} on your image so that it is highlighted. 

 
 

2. {Click} on the Hyperlink button . 
 
3. Enter the URL you wish the link to point to. 

 
4. Make sure that your <IMG> element has it’s BORDER attribute set to 

zero, otherwise it will have a box around it the same color as your 
hyperlinks. 

 
HTML View: 
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Image Maps  
 

Image maps are images that have been divided into link regions. 
{Clicking} in a region of the image causes the web surfer to connect to a 
new URL. Image maps are a graphical form of creating links between web 
pages.  
 
There are two types of image maps:  
1. client-side 
2. server-side 
 
Both types of image maps involve a listing of co-ordinates that define the 
regions and which URLs those co-ordinates are associated with. This is 
known as the map file.  
 
 

Server-side Image Maps  
 

Server-side image maps (called ISMAP) involve a separate map file that is 
linked to the image by a program running on a Web server. Server-side 
image maps are one of two flavors NCSA - National Center for 
Supercomputer Applications or CERN - Conseil European pour la 
Recherche NucLaire.   
 
<A HREF=”http://sitename/picture.map”> 
<IMG ISMAP SRC=”Picture.gif” BORDER=0> 
</A> 

 
CERN Style: picture.map file 
 

default filename.htm 
circle (123,160) 20 next.htm 

 
NCSA Style: picture.map file 
 

default filename.htm 
circle next.htm 123,160 123,180 

 
Supported Shapes: 
• Circle – Center-point radius or, for NCSA center, edge point 
• Poly – List of vertices, max. 100, that define an irregular space 
• Rect – Upper-left, and Lower-right 
• Point – single spot, coordinates are x,y 

 
Note: Server-side images maps are not commonly used, since the 
invention of Client-side Image Maps. 
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Client-side Image Maps  
 

Client-side image maps (USEMAP) use a map file that is part of the HTML 
document (in an element called MAP), and is linked to the image by the 
browser.  
 
<IMG SRC=”Picture.gif” USEMAP=”#map1”> 
 
<MAP NAME=”map1”>  
<AREA SHAPE=”RECT” COORDS=”9,120, 56,149” 
HREF=”whatever.htm”>   
<AREA SHAPE=”RECT” COORDS=”100,200, 156,249” 
HREF=”wherever.htm”> 
</MAP> 
 
SHAPE: 
• RECT, or RECTANGLE: require four coordinates: X1, Y1, X2, and Y2 
• CIRC, or CIRCLE: requires three coordinates centerx, centery, and 

radius 
• POLY, or POLYGON: requires three or more pairs of coordinates 

 
 

Creating Image Maps in FrontPage  
 
FrontPage’s Pictures Toolbar:  

 
 

An easy way to create image maps is to use the Image Mapping toolbar. 
By default, this toolbar is turned off. It appears only when you insert an 
image, and becomes active when an image is selected. 
 
1. Select the image.  
 
2. Select an area drawing tool: circle, rectangle, or polygon. 

 
3. {Click} and drag the pointer to define the mapped area or “hotspot”. 

 
4. Enter information in the dialogue box. 

 
5. {Click} OK 

 
6. Once you have finished creating your image’s hotspots, {Click} OK. 
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HTML View: 

 
 

Changing an Image Map’s Hot Spots  
1. Select the hot spot by {Clicking} on it. Notice how a bounding box with 

sizing handles at each corner surrounds it.  
 
2. {Click} and drag the hotspot to a new location or use the arrow keys to 

nudge the hotspot one pixel at a time.  
 
 

Changing an Image Map’s Size  
1. Select the hot spot by {Clicking} on it once. 
 
2. Drag the hot spot’s resizing handles to change its width or height. 

 
 

Deleting an Image Map’s Hot Spots  
1. Select the hot spot by {Clicking} on it once.  
 
2. Locate the “Edit” menu and {Click} on the Clear option once. Or, press 

the Delete key. 
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Chapter 8 – Exercise - Adding Images 
 

1. Create a new document in FrontPage. 
 

2. Using the Microsoft Clip Art Gallery select a graphic from the images 
available and insert it into your web page.  

 
3. Work with the alignment properties to get the image positioned where 

you like it on the page.  
 

4. Try changing the VSpace and HSpace properties to see the effect. 
 

5. Add a border to one or more of your images. 
 

6. Switch from Normal View to HTML View. Your document should look 
similar to the following: 

 
HTML View:  

 
 

7. Switch back from HTML View to Normal View. Your document should 
look similar to the following: 

 
 

Normal View: 
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Chapter 8 – Optional Exercise 
 

1. Try adding a graphic image from a file location, not from the gallery.  
 

2. Use the Insert Image button to add one of the graphics located in 
C:\Fpfiles\images\ directory. 
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Review Questions 
 
1. Why should you describe the image in the ALT parameter? 
 
 
 
2. Why do you use transparency for your graphics? 
 
 
 
3. Why would you reduce the number of colors in a graphic image? 
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Summary 
 

As a result of this chapter, you should be able to:  
 
• Distinguish between supported graphics formats and unsupported 

graphics formats 
 

• Determine which graphic format is best suited for the type of image 
 
• Add images to your web documents 
 
• Use the Microsoft Image Gallery to add an image 
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9 
 

Tables 
 
 
 

In this chapter you learn that tables have many uses in HTML.  The most 
obvious is a table of data, but tables can also be used for advanced 
layout, such as placing text and graphics on a page at just the right spot, 
as well as placing form input boxes and simulating columns. 

 
 
Objectives 

 
Upon completing this section, you should be able to:  

 
1. Create a Table 

 
2. Change a table’s properties 

 
3. Edit a table 

 
4. Add a caption 
 
5. Modify a Table Cell and it’s properties 
 
6. Perform advanced Table editing 
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Tables  
 

The <TABLE> </TABLE> element has four sub-elements; Table Row 
<TR></TR>, Table Header <TH></TH>, Table Data <TD> </TD>, and 
Caption <CAPTION> </CAPTION>. The Table Row elements usually 
contain Table Header elements or Table Data elements. The Table 
Header and Table Data elements can contain several of the body 
elements, which allows for rich formatting of the data in the table.  
 
HTML View: Table Sample 

 
 
Normal View: 
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Inserting a Table  
 

You can insert a table by {Clicking} on the table  icon on either the 
Standard Toolbar or by selecting the Insert Table... command in the 
“Table” menu. The Table Icon and the Insert Table... menu item will be 
grayed out if your cursor is not at a valid location in the HTML Document 
for a table. 
 

 
 

 
 
 
Rows and Columns:  
The number of rows and columns in the table, this will create <TR></TR> 
sets for the rows and <TD></TD> sets for the columns. 
 
ALIGN - Alignment:   
You can set the table to align to the left, center, right or justify. 
 
WIDTH – Width:  
You can specify the table width as an absolute number of pixels or a 
percentage of the document width.  The width corresponds to the WIDTH 
attribute of the TABLE element.  You can set the width for table cells as 
well. 
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BORDER - Border:  
The lines that form the boundary of each table cell when the file is 
displayed in a browser.  You can choose a numerical value for the border 
width specified in pixels.  You can choose your selection from a drop down 
list or enter it manually in the text box provided.  The table border 
corresponds to the BORDER attribute of the TABLE element.  A setting of 
zero will make the border invisible. 
 
CELLPADDING - Cell Padding:   
To modify the area of transparent space around the contents of your cells 
increase or decrease cell padding accordingly. 
 
CELLSPACING - Cell Spacing:   
To modify the area of space between each cell, without modifying the size 
of the cells increase or decrease cell spacing accordingly. 
 
NOTE: Some browsers do not draw borders around empty table cells, 
placing a &nbsp; will cause the browser to display the border and make 
the cell appear empty. 
 
HTML View: 

 
 
Results in Preview: 
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Changing a Table’s Properties  
 
Once you have created the table, you will want to edit some of the other 
key attributes of the table. 
 
You can edit a table’s properties by positioning your cursor inside a cell of 
the table and using either: 
 
1. A {Right Click} and choosing Table Properties… 
 
2. The Table Menu ! Table Properties 
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Table Properties  
 

You can change all the regular properties of your table by selecting the 
option from the “Table Properties” dialog box. The Table Properties dialog 
box allows you to edit the table and changes will be reflected when you 
{Click} the “Apply” button. 

 

 
 
All of the properties discussed are available from this dialog box. 

 
Alignment:  
This indicates the table’s positioning on the page. There are four options 
of alignment: Default, Left, Right and Center. FrontPage uses the <DIV> 
element to align tables, will go into more detail on <DIV> in the Cascading 
Style Sheet Chapter. 
  
ALIGN - Float:  
Allows you to have text flow to the right of the table, left of the table, or not 
at all. This option sets the ALIGN attribute of the <TABLE> element. 
 
CELLPADDING - Cell padding:  
This sets the space between the contents and inside edges of cells. You 
can only set the cell padding for an entire table. The default setting for cell 
padding is one. 
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CELLPADDING - Cell spacing:   
This sets the spacing of the cells in a table. Cell spacing determines how 
much space is placed between all the cells in a table. You can only set the 
cell spacing for an entire table. The default setting for cell spacing is two. 
 
WIDTH - Table Width:  
Used to specify the minimum width of the table in either pixels or 
percentage. If the table’s size is not specified, the web browser may scale 
the table, thus changing how the table will appear. Specifying the width of 
the table in pixels guarantees that the web browser will not scale the table 
inappropriately. A table width that is specified in percentage will inevitably 
alter its appearance as a user’s monitor resolution may be changed to a 
larger or smaller setting. 
 
HEIGHT - Table Height:  
Used to specify the height of the table in either pixels or percentage. The 
guidelines of the table’s width also apply to its height. 
 
BORDER - Border:  
Sets the color of the table’s entire border with this option. 
 
BORDERCOLOR – Border Color:  
The color of the border around the table.  This is supported properly by 
Navigator 4.0 and Internet Explorer 3.0 and above. 
 
BORDERCOLORLIGHT - Light Border:  
Sets one of the table’s border colors. This is used to create three-
dimensional effect. Supported only in Internet Explorer 2.0 and above. 
 
BORDERCOLORDARK - Dark Border:  
Sets one of the table’s border colors. This is used to create three-
dimensional effect. Supported in Internet Explorer 2.0 and above. 
 
BGCOLOR - Background Color:  
This option allows you to set a different color for the table than the 
document’s background color. You can select a color from the palette or 
choose to customize one.  
 
BACKGROUND - Background Picture:  
This allows you to select an image for the table’s background. Only 
current versions of web browsers support this option. 
 
 



 
 

Learn Web Development in a classroom @  http://www.xnu.com Call 1-416-675-1881 117 
 

FrontPage Tip  
  

 
The most appropriate setting for a table’s width is 600 pixels. This 
guarantees that users who have their monitors set at 640 x 480 resolution 
will not have to scroll to the right to view your web page. Monitors set at 
greater resolutions will also display your table correctly. 
  

 
 
Table Caption 
  

A Table caption allows you to specify a line of text that will appear 
centered above or below the table.  This can act like a title for the table. 
 

 
 

The caption element has one attribute VALIGN that can be either TOP 
(above the table) or BOTTOM (below the table). You can use character-
formatting codes inside the Caption element. 
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HTML View: 

 
 
Note: The <CAPTION> element is located just inside the <TABLE> 
element. 
 
Results in Preview: 
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TH - Table Header 
  

Table Data cells are represented by the TD element. Cells can be 
changed to TH (Table Header) elements, which results in the contents of 
the Table Header cells appearing in bold text. 
 
Rows, columns or individual cells can be changed to Table Header cells or 
to Table Data cells by  {Right Clicking} in the cell, row or column that you 
want to change. Select “Cell Properties” from the pop up dialogue box; 
{Click} the Header cell check box; choose Apply to see the result or {Click} 
OK to apply and close the dialogue box. 
 
If you simply wish to bold the text, we suggest that you insert a <B> 
element inside the table cell(s) instead of changing the table cell element. 
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Cell Properties 
 

The Cell Properties Dialog Box is used to set the properties of a specific 
cell. To change the particular settings of a cell, place your cursor within 
that cell and {Right Click}. 
 

 
 
ALIGN - Alignment:  
This sets the alignment for the cell’s content. Options include default, left, 
center and right. 
 
VALIGN - Vertical Alignment:  
This sets the vertical alignment of the cells content. The settings are 
Default (Middle), Top, Baseline and Bottom. 
 
WIDTH - Specify Width:  
Sets the width of the cell in pixels or as a percentage. 
 
HEIGHT - Specify Height:  
Sets the height of the cell in pixels or as a percentage. 
 
ROWSPAN - Number of Rows Spanned:  
Sets the number of rows a cell should extend across. 
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COLSPAN - Number of Columns Spanned:  
Sets the number of columns a cell should extend across. 
 
TH - Header Cell:  
Sets the text in the cell to bold. 
 
NOWRAP - No Wrap:  
This ensures that Web browsers do not wrap the text inside the cell. If this 
option is not selected, the text in the cell might be wrapped. 
 
BORDER - Border:  
Select a color for the entire cell’s border. 
 
BORDERCOLORLIGHT - Light Border:  
Select a color for one of the cells border colors. This creates a three 
dimensional effect. 
 
BORDERCOLORDARK - Dark Border:  
Select a color for one of the cells border colors. This creates a three 
dimensional effect. 
 
BGCOLOR - Background Color:  
Allows you to choose a color for the cell’s background. Cells within a color 
can have different colors. 
 
BACKGROUND - Background Picture:  
Allows you to choose an image for the cell’s background. 
 
HTML View: 
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Advanced Table Editing 
 

Once you have inserted a table, you can: 
• Add or delete a single row or column. 
• Merge rows or columns together. 

 
You can edit the Table by using the commands available in the Table 
Menu or from the Table Toolbar.  
 
Table Toolbar: 

 
 

Draw Table, Eraser 
Insert Rows, Insert Columns, and Delete Cells 
Merge Cells, Split Cells 
Align Top, Center Vertically, and Align Bottom 
Fill Color 
Auto Fit 

 
NOTE: The [ENTER] key will place a <BR></BR> inside a cell instead of a 
paragraph. 
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Chapter 9 – Exercise 1 
 

1. Insert a table above the bottom Horizontal Rule. 
 

2. Change its background color to yellow. 
 

3. Increase the table’s border to a setting of 5. 
 

4. Change the Top Row to a table Heading, and add some headings. 
 

5. Add some text/data to your table. 
 

6. Center the table using the Center element. 
 

7. Center the address using the Center element. 
 

8. Save and Preview. 
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Review Questions 
 

1. When you insert a table what are the initial properties that you can 
specify through the dialog box? 

 
 
2. How would you set other key attributes such as alignment and cell 

padding? 
 

 
3. What is Cell Spacing? 
 
 
4. How do you change a row into Table Header cells? 
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Summary 
 

As a result of this chapter, you should be able to:  
 
• Insert a table 
 
• Explain a table’s properties 
 
• Edit a table 
 
• Add a table header 

 
 



 

126 XtraNet U – The place to learn how to develop for the web – http://www.xnu.com 
 

 

10 
 

Frames 
 
 

 
Frames are a relatively new addition to the HTML standard, having been 
included in release 3.0 and therefore not all browsers support this group of 
elements.  Popular browsers, such as Netscape and Internet Explorer 
releases 3.0 and higher do provide full frames support.   
 

Objectives 
 
Upon completing this section, you should be able to:  
 
1. Create a Frames based page 
 
2. Work with the Frameset, Frame, and Noframes elements 
 
3. Use the attributes of the Frames elements to control the display 

 
4. Set Targets appropriately 

 
Prerequisites 
 

• Internet Explorer 3.0 or greater 
 
• Navigator 2.0 or greater 

 
• Frames are Platform Independent 

 
 



 
 

Learn Web Development in a classroom @  http://www.xnu.com Call 1-416-675-1881 127 
 

Introduction to Frames  
 

A frames page is best described as a page that divides the browser’s 
window into multiple windowpanes (frames). The key document (the 
frames page) divides the browser’s display area into separate regions 
(frames). It also indicates the content HTML pages that will be 
downloaded and displayed in each frame. 
 
Lets examine an example of a framed page that has three viewable 
frames. This type of page is actually made up of four HTML pages. One 
page of the four describes the divisions of the window into three frames.  
It also gives a unique name to each frame, and lists the URL of the 
content page that will be loaded into that frame. The other three HTML 
pages are the contents of the frames and are loaded into each frame as 
indicated by the frames page. 
 

 
 
To review, your browser first downloads the frames page from the web 
server to your browser. Your browser divides the active window into 
multiple frames. Your browser then downloads each of the pages 
indicated by the frames page into the appropriate frame. 
 
Frames are typically used as a layout solution.  By placing an HTML page 
made up of your Navigation bar or links in one Frame you ensure that the 
Navigation options are always available to the user because you can 
designate the pages that the links point to are displayed in another frame. 
 
Framed sites can be more work because of the number of pages involved. 
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The Anatomy of a Frames Page  
 
A frames page is different than a normal HTML document. Below is an 
example: 
 

 
 
You can see that <FRAMESET> element is replacing the position of the 
<BODY> element. The <FRAMESET> element is the one that defines the 
division of the window into multiple panes (frames). The sub element of 
<FRAMESET> is <FRAME> that names the windowpane (frame) and 
specifies the web page that will populate that windowpane (frame). 
 
When older browsers read pages written to a higher standard of HTML 
they ignore any elements that they do not understand. The early browsers 
did not support frames, so they will ignore all the <FRAMESET>, 
<FRAME> and <NOFRAMES> elements. This will leave you with the 
<BODY> element between the <NOFRAMES> element. A browser that 
does not support frames will only see the code between the <BODY> 
elements. 
 
The reverse is also true. A new browser will ignore everything between the 
<NOFRAMES> elements. 
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Editor View Tabs  
 

When you begin working with frames pages the editor adds additional 
views to make it easier to work with. 
 

 
 
 
Normal View  
This view gives you an approximate idea of how your web page will 
appear.  
 
No Frames 
This view displays the page that will appear in web browsers that cannot 
view a page created in frames.  Some web pages will inform the user that 
the page is viewed only with a frames capable browser. Other web sites 
will give the visitor the option of viewing the document in a page formatted 
without frames. 
 
HTML View 
This view displays the HTML coding of all the different pages within the 
frames. To edit a specific page’s HTML coding {Click} on the specific 
frame. 
 
Frames Page HTML 
This view displays the main document of the web page. It displays the 
HTML coding that divides the web page into separate regions and its 
properties. 
 
Preview 
This view allows you to see how your web page will appear on the 
Internet. 
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<FRAMESET> 
 

The <FRAMESET>element contains information about how the active 
window is divided. If you use one of FrontPage’s frame templates, the 
properties within the <FRAMESET> element will be pre-determined. You 
can however modify the properties in the Frames Page HTML View. 
 
ROWS: 
Determines the size and number of rectangular rows within a 
<FRAMESET>.  They are set from the top of the display area to the 
bottom. 
 
Possible values are: 
• absolute pixel units, E.g. “360.120”  
• a percentage of screen height, E.g. “75%,25%” 
• relative values using the asterisk (*) character, E.g. “100, *” 
 
The latter enables the developer to allocate all unassigned vertical space 
proportionately. Values are given within quotation marks and separated by 
commas. 
 
COLS: 
Determines the size and number of rectangular columns within a 
<FRAMESET>.  They are set from left to right of the display area. 
 
Possible values are: 
• absolute pixel units, E.g. “480,160”  
• a percentage of screen height, E.g. “75%,25%” 
• relative values using the asterisk (*) character, E.g. “100, *” 
 
The latter enables the developer to allocate all unassigned horizontal 
space proportionately. Values are given within quotation marks and 
separated by commas. 
 
FRAMEBORDER: 
Possible values 0, 1, YES, NO. A setting of zero creates a borderless 
frame. 

 
FRAMESPACING: 
This property specifies the amount of padding, in pixels, between frames 
when the frames page is displayed in a Web browser. The default for most 
Web browsers is 2 pixels. 
Frames can be borderless, but you will need to change this value to zero 
as well, or you will have a gap between your frames where the border 
used to be. 
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<FRAME>  
  

This element defines a single frame within a frameset.  To edit a frame’s 
properties, locate the “Frame” menu and select “Frame Properties.” 
Another method of modifying the properties of the <FRAME> element is to 
select the frame and {Right Click} anywhere in the frame.  
 

  
 

Name:  
Required, as it names the frame. The name is used to allow targeting by 
other HTML documents. In order to place a document other than the one 
specified by the Initial Page property in this frame you will need to 
reference its name. Frame names are case sensitive we suggest you 
always use lowercase names. 

 
Resizable in Browser: 
When checked, this option allows users to resize the frame in a web 
browser. If this is disabled, users will view the page at the preset size in 
their web browser. 

 
Show Scrollbars: 
This specifies the use of scrollbars around the frame when displayed in a 
web browser. There are three options to choose from:  

• If Needed: This displays scrollbars if the content within the frame 
cannot be viewed without scrolling. 

• Never: This option turns off scrollbars. 
• Always: This option turns on scrollbars. 
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Frame Size: 
This determines the size of the frame relative to the other frames within 
the document. The specific size of the frame changes depending on 
whether it belongs to a row or a column.  If you decide to change a 
frame’s size during the editing process FrontPage automatically updates 
any changes that are made to the individual frame in the <FRAMESET>. 

 
Column Width/Height:  
This option is enabled when the frame selected belongs to a column that 
contains other frames of the same size above or below it. You can specify 
both the column width and height of frame as follows: 
 
1. In values that are relative to other frames in the same column.  
2. As a percent of the size of the window when the frames page is 

displayed in a Web browser. 
3. In a fixed number of pixels. 
 
If you change the column width for the selected frame the change will be 
applied uniformly to all other frames in that column. The sizes of frames in 
other columns to the left or right of the selected frame will be adjusted 
accordingly. 

 
Width/Row Height: 
This option is enabled when the selected frame belongs to a row that 
contains other frames of the same size to the right or left of it. You can 
specify the frame’s row width and height as follows: 
 
1. In values that are relative to other frames in the same row.  
2. As a percent of the size of the window when the frames page is 

displayed in a Web browser. 
3. In a fixed number of pixels. 
 
If you change the row height for the selected frame, the change will be 
applied uniformly to all other frames in that row. The sizes of frames in 
other rows above or below the selected frame will be adjusted accordingly. 

 
Margin Width: 
This option specifies the width, in pixels, that the contents of the frame 
should be indented from the left and right frame borders. 
 
Margin Height: 
This option specifies the height, in pixels, that the contents of the frame 
should be indented from the top and bottom frame borders. 
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Initial Page: 
Required, as it provides the URL for the page that will be displayed in the 
frame. 

 
 
Creating a Frames Page  
 

Creating a frames page with FrontPage is a quick and simple task.  
 
1. Go to the “File” menu and {Click} on “New.” 
 
2. {Click} on the “Frames” tab and select a template for your frames page. 

In the dialog box, you will be able to see what each frames template 
looks like in the “Preview” window. 

 
3. Once you have selected a template that suits your needs {Click} OK. 

FrontPage immediately creates the frames environment and you can 
begin editing your page. 

 

 
 
The Frames Dialog Box provides you with several different templates to 
choose from.  You can see what each template will look like in the Preview 
window and a short explanation of the document’s structure is detailed in 
the “Description” section.  
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In this example, the frames document consists of three frames that will 
contain three different documents. Each frame region has three buttons 
that allows you to insert a pre-existing page into a frame or to create a 
new page.  
 
Set Initial Page Button 
Sets the page that will be viewed in that particular frame. {Clicking} on this 
button will initiate the “Create Hyperlink” dialog box. Locate the specific file 
within a directory on your computer/server or you may link to a file on the 
Internet. 
 
New Page Button 
This button also sets the page that will be viewed in that particular frame, 
however, instead of choosing a pre-existing file, it causes a new page to 
be created for future editing.  
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Frame Properties   
 
Using the FrontPage editor, you can easily modify the frame properties of 
the main document or individual framed pages. 
 
 

Editing the Frame Page’s HTML  
 
Switch to the Frames Page HTML View. Your document should look 
similar to the following: 
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Targets  
 

Since we now have multiple windows to deal with, we have to have a way 
of identifying them so that our other pages end up in the correct frame. 
Earlier in the chapter we stressed that we should name our frames with 
lowercase names.  We did this because the names become the value of 
the TARGET attribute for any element that links to another HTML 
document. If you fail to specify a TARGET then the HTML document will 
be loaded into the current frame. 
 
A “target” is used with the <A>, <AREA>, <BASE> and <FORM> 
elements; its purpose is to ‘target’ or redirect the hyperlink to a specific 
frame. The target attribute has the following syntax: 

 
<A HREF="framedoc.htm" TARGET="Frame-window-name"> 
 
<AREA SHAPE="RECT" COORDS="5,15,25,40" HREF="framedoc.htm" 
TARGET="Frame-window-name"> 
 
<BASE TARGET="Frame-window-name"> 
 
<FORM ACTION="cgi bin/script" TARGET="Frame-window-name"> 
 
 

Creating a Frame Target  
 

To specify a frame target, in which to display a page pointed to by a 

hyperlink, create a link by {Clicking} on the Create/Edit Hyperlink  
button. 
 
1. In the Hyperlink Dialog Box, select the file or insert the URL of the web 

page you want to link too.  
 
2. Locate the “Target Frame” section in the Hyperlink Dialog Box and 

{Click} on the “Edit Target” button . 
 

3. In the Target Dialog Box, you are provided with five (5) common target 
options: 
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Page Default 
Specifies that the page pointed to by the hyperlink should be displayed in 
the default target frame for the active page.  
 
Same Frame 
Sets the target frame of the hyperlink to the same frame that contains the 
hyperlink. Use this setting to override the page's default target frame. 
 
Whole Page 
Sets the target frame of the hyperlink to the entire Web browser window. 
 
New Window  
Sets the target frame of the hyperlink to open a new browser window on 
the user’s desktop.  
 
Parent Frame 
Specifies to display the page that is the target of the hyperlink in the frame 
that contains the current frameset tag. This is an advanced feature. 
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Editing Frames  
 
You can edit existing frames by {Clicking} on the “Frames” menu in 
FrontPage.  
 

 
 
Split Frame 
This option is used to split the current frame. You can choose whether to 
split the frame horizontally or vertically to create two new frames. The 
contents of the original frame appear in the left frame (if you split the 
original frame into columns) or in the top frame (if you split the frame into 
rows).  
 
Delete Frame 
This option is used to delete the current frame selected. You can also 
delete a frame by {Clicking} on the frame and hitting the Delete Key. 
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Chapter 10 – Exercise 1 
 

In this exercise you will work with a frames based page. 
 

Procedure 
 

1. In your browser open the file called frames.htm; it is located in the 
c:\Fpfiles\frames\ directory. 
 

2. {Click} on the links in the frame on the left, notice how the content on 
the right changes. 

 
 
Chapter 10 – Exercise 2 

 
In this exercise you will add a link to the page in the frame on the left. 
 

Procedure 
 
1. Open the site_menu.htm page in the c:\fpfiles\frames\ directory. 
 
2. Select the words “Our Products” and {Click} on the Insert Link Button. 
 
3. In the Hyperlink dialog box, locate the file called products.htm. 
 
4. In the Target Frame field, use the Page Default (Main) setting.  

 
5. Save the file, and reload the frames.htm document in your browser. 

{Click} on the words “Our Products” and observe what happens. 
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Review Questions 
 

1. What is the TARGET attribute used for? 
 
 
 
2. What are two attributes of the FRAMESET element? 
 
 
 
3. What is the NOFRAMES element used for? 
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Summary 
 

As a result of this chapter, you should be able to:  
 
• Create a Frames based page 
 
• Work with the Frameset, Frame, and NoFrames elements 
 
• Use the attributes of the Frames elements to control the display 
 
• Set Targets appropriately 
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11 
 

Forms 
 
 

Forms enable web pages to not only provide the person viewing the 
document with dynamic information but also to obtain information from the 
person viewing it and process that information. 

 
Objectives 

 
Upon completing this section, you should be able to:  

 
1. Create a FORM 
 
2. Add elements to a FORM 

 
3. Define CGI 
 
4. Describe the purpose of a CGI Application 
 
5. Specify an action for the FORM 

  
Prerequisites 

 
• Forms work in all browsers 
 
• Forms are Platform Independent 
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Forms  
 

A form is a set of data-entry fields on a page that are processed on a 
server. The data is sent to the server when a user submits the form by 
{Clicking} on a button or an image. Fields are the building blocks of forms.  
 
To insert a form into your web page, locate the “Insert” menu and select 
“Form.”  To insert a form field select one of six available field types.   

 
 
<FORM> 
 

The Form element contains properties that are invisible to the user, but 
are essential in specifying how the data will be processed, transported and 
encoded. 

 
ACTION:   
Is the URL of the CGI (Common Gateway Interface) program that is going 
to accept the data from the form, process it, and send a response back to 
the browser. 

 
METHOD: 
GET (default) or POST specifies which HTTP method will be used to send 
the form’s contents to the web server. The CGI application should be 
written to accept the data from either method. 

 
ENCTYPE: 
Determines the mechanism used to encode the forms contents (leave 
default.) 

 
NAME:  
Is a form name used by VB script or JavaScript.  

 
TARGET: 
Is the target frame where the response page will be displayed to the user. 

 
The rest of the form elements are used to create the form displayed in the 
browser and collect the data to be sent to the application. 
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Form Properties 
 

  
 
Send to 
If you do not require your form to be processed by a CGI script you can 
use this option to generate a text file.  To save the file in a particular 
directory select browse and choose the directory.  You must enter a 
filename with a .txt extension.  To E-mail the results of the form enter an 
appropriate E-mail address.   To control the format of the results select 
“Options.” 

 
Send to other 
Select this option if the results of your form are being processed by a 
script, a discussion group handler, or a registration handler.  Select 
“Options” to configure the required parameters for forms processed by 
scripts and handlers. 

 
Form Name 
Enter the name you have chosen for the form here. 

 
Target Frame 
If you have chosen to generate a response page for your form, informing 
the user that is has been successfully or unsuccessfully processed for 
example, you can designate if the response page appears in Page 
Default, Same Frame, Whole Page, New Window, or Parent Frame. 

 
Options 
Select “Options” to configure parameters for either “Send to” or “Send to 
other.”  If you selected “Send to” you can configure the following options: 
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File Results, E-mail Results, Confirmation Field, and Saved Fields.  If you 
selected “Send to other” you can configure the following options: Action, 
Method, Encoding Type, and Style. 

 
Advanced  
Select “Advanced” to add Hidden fields to your form.  Select “Add” to 
create new hidden fields.  “Modify” to modify existing hidden fields and 
“Remove” to delete existing hidden fields. 

 
 
Form Elements  
 

Form elements also have properties called “form fields.” A form field is 
where the user fills in or selects information to be submitted. FrontPage 
provides you with the following fields: One-Line Text Box, Scrolling Text 
Box, Check Box, Radio Button, Drop-Down Menu, and Push Button. 

 
You can insert form fields by {Clicking} on the “Insert” menu, selecting 
“Form” and selecting the desired field type.  

 
<INPUT> Elements Properties 

TYPE = Type of INPUT entry field 
NAME =  Variable name passed to CGI 

application 
VALUE = The data associated with the variable 

name to be passed to the CGI 
application 

CHECKED = Button/box checked by default 
SIZE = Number of characters in text field 

MAXLENGTH = Maximum number of characters 
accepted 
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Field Types 
 

Text boxes:  
To create a textbox, {Click} on the Insert Text box button   
 

 
 
You can edit the properties of the text box by {Right Clicking} on the text 
box and selecting “Form Field Properties.”  
 

 
 
In the Text Box Properties dialog box, you can modify the following 
attributes: 

 
Name:  
The name of the variable to be sent to the CGI application. 
 
Initial Value:  
Usually left blank, but can have a default value. 
 
Width in Characters:  
The number of characters the user can enter in the text box. You can also 
change the size of the text box by dragging the sizing handles. 
 
Tab Order:  
Controls the order in which the user can move from field to field. 
 
Password field:  
A text box can be used as a password field for user validation.  
 
Validate:  
This button displays the Form Field Validation dialog box. The Validation 
dialog box controls what the user can enter in the text box. 
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Check Box:   
 
Check boxes allow the users to select more than one option. To insert a 

check box {Click} on . 
 

 
 

 
 

Name:  
The name of the variable to be sent to the CGI application. 
 
Value: 
The default value is on but can be changed to OFF. 
 
Initial Status:  
The status of whether it will appear checked or unchecked when displayed 
in the web browser. 
 
Tab Order:  
Controls the order in which the user can move from field to field. 
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Radio Button:   
 
Radio buttons allow users to select only one option. To insert a radio 
button {Click} on . 

 

 
 

 
 

Name:  
The name of the variable to be sent to the CGI application. 
 
Value:  
The value associated with the button. Each radio button must have its own 
value. 
 
Initial Status:  
The status of whether it will be selected or not selected when displayed in 
the web browser. 
 
Tab Order:  
Controls the order in which the user can move from field to field. 
 
Validate:  
This button displays the Form Field Validation dialog box.  Use it to define 
the group a set of radio buttons belong to, the value of each button, the 
initial selection state, and the tap order. 
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Push Button:  
 
Push Buttons are elements used with either JavaScript or VBScript to 
cause an action to take place. 
To add a push button {Click} on  . 
 

The result is a button . 
 

 
 
Name: 
The name of the variable sent to the CGI application. 
 
Value/Label: 
The label of the push button. If you supply a label, it replaces the default 
label on the push button.  
 
Button type: 
Select Submit to use the button to submit the form; when you select 
Submit, the default label is Submit. Select Reset to use the button to reset 
the form to its initial state; when you select Reset, the default label is 
Reset. Select Normal if you want to insert a generic button to which you 
can assign a script; when you select Normal, the default label is Button. 
 
Tab Order: 
Controls the order in which the user can move from field to field. 
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 Scrolling Text Box:  
 
Allows users to input multiple lines of text.  To insert a scrolling text box 
{Click} on . 
 

 
 

You can edit the properties of the scrolling text box by {Right Clicking} on 
the scrolling text box and selecting “Form Field Properties.” 
 

 
 
Name: 
The name of the variable to be sent to the CGI application. 
 
Initial Value:  
Usually left blank, but can have a default value. 
 
Width in Characters: 
The number of characters the user can enter in the scrolling text box. You 
can also change the size of the scrolling text box by dragging the sizing 
handles. 
 
Number of Lines: 
The number of lines or height of the scrolling text box. 
 
Tab Order: 
Controls the order in which the user can move from field to field. 
 
Validate: 
This button displays the Form Field Validation dialog box. The Validation 
dialog box controls what the user can enter in the scrolling text box. 
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FrontPage Tip 
 

 
Add the WRAP attribute to the <TEXTAREA> </TEXTAREA> element in 
HTML view to ensure that text scrolls properly in Netscape browsers. You 
will need to type this in using the HTML View.  

 
 

 
 
Drop-Down Menu 
 

The following two are types of <SELECT> </SELECT> elements, where 
the elements are set differently. 

 
Drop-Down Menus contain a list of selections users choose from. 

 

 
 

Name: 
The name of the variable to be sent to the CGI application. 
Choice: lists the names of the menu choices associated with this drop-
down menu. You can add menu choices by {Clicking} on the “Add” button. 
Each choice is designated by <OPTION> </OPTION> tags in HTML. 
 
Selected:  
Choose whether you want the menu choice on the current row to be 
selected or not selected when it is first displayed in a Web browser. 
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Value:  
Sets the value of the menu choice on the current row. 
 
Move Up: 
{Click} Move Up to move the currently selected choice up in the 
menu. 

 
Move Down:  
{Click} Move Down to move the currently selected choice down in the 
menu. 
 
Height:  
{Click} Height to set the height of the menu. The height of a drop-down 
menu field controls how the menu appears: 

 
1. If the menu allows only 1 selection and the height is 1, most Web 

browsers display the menu as a drop-down list. 
 

2. If the menu allows only 1 selection and the height is larger than 1, 
most Web browsers display the menu as a scrollable list. 
 

3. If the menu allows more than 1 selection and the height is 1, most 
Web browsers display the menu as a scrollable list with half-height 
scroll arrows. This combination of settings makes it difficult to use 
the menu. 
 

4. If the menu allows more than 1 selection and the height is larger 
than 1, most Web browsers display the menu as a scrollable list 
with full-height scroll arrows. 

 
Allow multiple selections:  
Select Yes to allow more than one menu item to be selected at a time. 
Select No to permit only one selection at a time. 

 
Tab order:  
Controls the order in which the user can move from field to field. 
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Common Gateway Interface (CGI)  
  

When the user has finished filling in the form and presses submit the data 
is sent to the application on the server specified in the action attribute of 
the form element. 
 
The application is commonly referred to as a CGI application/program. It 
resides and runs on the web server. It is typically but not always stored in 
a directory called cgi-bin.  
 
The application can be written in any language; however, it must be one 
supported by your web server’s operating system and web server 
software. A very popular language for creating CGI applications is PERL 
(Practical Extraction Report Language).  
 
PERL is an interpreted language with rich text manipulation 
characteristics. Because it is interpreted its performance compared to a 
compiled CGI application is slower, thus negatively affecting server 
performance. It has been ported to most popular operating systems and is 
currently available for most versions of UNIX, Windows NT, and Windows 
95. The actual application is commonly referred to as a script.  

 
 
CGI Scripts 
 

CGI Scripts process the form's data and send a response back to the 
user.   
 
They can be written to calculate numbers as in a sales order.  They can 
format data and put it into a database such as a mailing list or guest book.  
Depending on the situation, a CGI Script can be written to do almost 
anything. 
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Intranet Application Development Architectures 
 
1. Simple CGI Program 

 

Web ServerBrowser

1

3

Client Server

2

 
 

1. The client fills out an HTML document containing the <FORM> element and presses the 
submit button. This sends the data the user entered to the web server.  
 
2. The web server receives the data and passes it to the program specified in the ACTION 
attribute of the <FORM> element. This program is called a CGI (Common Gateway Interface) 
program. It can be written in a number of languages; VBScript, JavaScript, PERL, C++, etc. It can 
perform a number of different functions. 
 
3. The CGI program creates a new HTML document on the fly and sends it to the client. 
 
 

Browser Web Server CGI Program 

Netscape Navigator Netscape Enterprise Server - NSAPI -C++ 
- PERL 
- Server side JavaScript 

Microsoft Internet Explorer Microsoft Internet 
Information Server 

- ISAPI -C++ 
- PERL 
- Active Server Pages (ASP) 

JScript or VBScript 
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2. Three-Tier Web Application Development 
 

Web Server Database ServerBrowser

1 2

4 3

Client Server  
 
1. The client fills out an HTML document containing the <FORM> element and presses the 
submit button. This sends the data the user entered to the web server.  
 
2. The web server receives the data and passes it to the program specified in the 
ACTION attribute of the <FORM> element. This program is called a CGI 
(Common Gateway Interface) program. It can be written in a number of 
languages; VBScript, JavaScript, PERL, C++, etc. 
 
The program in this case creates a command and issues it to the database server. 
 
3. The Database Server receives the command and issues it against the database. The 
data returned from the command is then sent back to the CGI application running on the 
web server. 
 
4. The CGI program creates a new HTML document on the fly with the data returned from the 
database server and sends it to the client. 
 

Browser Web Server CGI 
Program 

Database 
Server 

Netscape Navigator Netscape 
Enterprise Server 

- NSAPI -C++ 
- PERL 
- Server side 

JavaScript 

Microsoft Internet 
Explorer 

Microsoft Internet 
Information Server 

- ISAPI -C++ 
- PERL 
- Active Server Pages 

(ASP) 
JScript or VBScript 

 

- Oracle 
- Informix 
- Sybase 
- Microsoft SQL 
- Other ODBC  
  compliant 
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3. Four-Tier Web Application Development  
 

Web Server Database Server
Browser

Transaction Server

1

6

2

5

3

3
4

4

Client Server  
 
1. The client fills out an HTML document containing the <FORM> element and presses the 
submit button. This sends the data the user entered to the web server.  
 
2. The web server receives the data and passes it to the program specified in the ACTION 
attribute of the <FORM> element. This program is called a CGI (Common Gateway Interface) 
program.  
 
In this case the program invokes a transaction on the transaction server. 
 
3. The Database Server receives a command from the transaction server and issues it 
against the database. 
  
4. The data returned from the command is then sent back to the transaction, this cycle will 
continue until the transaction fails or completes. 
 
5. When the transaction completes successfully or unsuccessfully it passes the result to 
the web server. 
 
6. The CGI program running on the web server then creates a new HTML document on the fly 
with the data returned from the transaction server and sends it to the client. 
 
Transaction Server Choices: 
 - Microsoft Transaction Server 
 - Netscape Application Server  
 - Oracle Application Server 

 



 
 

Learn Web Development in a classroom @  http://www.xnu.com Call 1-416-675-1881 157 
 

Chapter 11 - Exercise 1 - Creating an Order Form 
 

In this exercise, you will create the order form for a car. You will need to 
provide a choice of options and colors, as well as space to fill in the name 
and phone number. 

 

 
 
Procedure 
 

1. In FrontPage create a new file. 
 
2. {Click} on the Text Input button on the Forms Toolbar or choose Insert 

Menu – Form – One-Line Text Box. This will create a blank, 20 
character text input box that allows the end-user to enter information 
into the form when they are viewing it in their browser. Position your 
cursor to the left of the text box but still inside the outline of the form. 
Type “Your First Name:” as a label for your text input field. 

 
3. {Right Click} and {Click} on the ‘Form Field Properties” on the Input box 

to edit the properties.  In the Name field type "NAME". 
 
4. {Click} OK. 
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5. Place the cursor to the right of the "NAME" input box, and hit the 
[ENTER] key.  This will give you a new empty paragraph. 

 
6. Type "Phone number: " and insert another text box with the Name field 

as “PHONE.” 
 
7. {Click} OK. 
 

Switch from Normal View to Preview. Your document should look similar 
to the following: 
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Chapter 11 - Exercise 2 - Radio Buttons 
 
Inserting Option/Radio Button elements so that the end-user may select 
the car they qualify for and the color they would prefer. 

 
Procedure 
 

1. Place the cursor to the right of the last text box field and press ENTER. 
Type in the following text: "Which car are you ordering?  Valona ". Add 
one space after Valona, and {Click} on the Radio button from the Insert 
Menu > Form options. 

 
2. Follow the same procedure for the Myrca and the Carollo. In order to 

make these choices mutually exclusive (so that it is only valid to make 
one choice), the properties of the radio buttons must be edited. 
 

3. {Right Click}  on each radio button and select “Form Field Properties”,  
and type “CAR” in the Name field. In the Value field, enter “Valona” 
and {Click} OK. 
 

4. Follow the same procedure for the radio buttons for the other two cars, 
Typing "CAR" in the name field and entering the type of car (Valona, 
Myrca or Carollo) in the Value Box. By providing the same name for 
each of these buttons, the user is restricted to selection only one 
button. 
 

5. Using the same procedure as above, insert a paragraph, type the text: 
" Color?  ", and create a radio button for each of the following colors: 
red, white, black, blue, green and yellow.  Remember to {Right Click} 
on each of these radio buttons and select “Form Field Properties”, and 
provide the same Name but a different Value. The Name box for each 
color should be COLOR.  The value box will be the Color name E.g. 
Red or White etc. 
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Chapter 11 - Exercise 3 - Adding Checkboxes 
 

Include a list of options that the end-user can choose from when ordering 
a car. These selections will not be mutually exclusive, since a car could be 
equipped with many options. 

 
Procedure 
 

1. Place your cursor on the last line of radio buttons and {Click} ENTER 
once. Type: “What options would you like?” 
 

2. Press the [ENTER] key to get a new, empty paragraph, and type: 
"Moon Roof."  Add a space and {Click} on the Checkbox button  on 
the FORMS menu. 
 

3. {Right Click} on the Checkbox, select “Form Field Properties.” Enter 
"Moon Roof" in the Name Box. 
 

4. Repeat this process adding other options: Bucket Seats, Remote 
Keyless Entry, Alarm System and Deluxe Stereo. 
 

5. Insert a Push Button and {Right Click} on it to change its properties so 
that it is a Submit Button. Enter the VALUE of the Submit Button as 
“Order Car.” 

 
6. {Click} OK and Save your file. 
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Now setup where the form’s data will be processed. 
 

7. Select the “Order Car” submission button and {Right Click} on it once. 
From the pop-up menu choose the option “Form Field Properties.” 
 

8. For testing purposes, you may use the "Form Test" CGI Script located 
on the XtraNet University Web Server. To employ a CGI script using 
FrontPage, {Click} on the radio button labeled: “Send to Other” and 
choose the option, “Custom ISAPI, NSAPI, CGI or ASP Script”  
 

9. {Click} on the button labeled “Options” and fill in the following 
information: 
 

10.  Action: http://www.xnu.com/formtest.asp 
 Method: Get 

 
11.  Save your document and preview it in your browser.  
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Review Questions 
 

1. When would you use Check boxes over Option/Radio Buttons? 
 
 
 
2. Do you need a submit button? 
 
 
 
3. Where does the data entered in the form go? 
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Summary 
 

As a result of this chapter, you should be able to:  
 
• Create a FORM. 
 
• Add elements to a FORM. 

 
• Define CGI. 
 
• Describe the purpose of a CGI Application. 
 
• Specify an action for the FORM. 
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12 
 

Special Elements 
 

In this chapter you learn to create animated pages using a Meta element 
and how to use the Meta element to help index your website on the 
Internet. You will also learn how to use some additional elements that 
allow you to add background sound, scrolling text, and blinking text. 

 
Objectives 

 
Upon completing this section, you should be able to:  

 
1. Create live pages using the Meta element 

 
2. Use the Meta element to add information relevant to Internet search 

engines and people viewing your source code 
 

3. Add background sound to an HTML page 
 

4. Add a Marquee 
 

5. Add Blinking text 
  
Prerequisites 
 

• The requirements are described with each element. 
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Uses of the Meta Element  
 
 

Client Pull, Server Push 
 

Client pull is different in that the HTML page has a META element inside 
the HEAD element of the document which instructs the browser to do 
something, which in this case is REFRESH itself.  The other instructions 
specify the time interval and the URL to be used.  In this way a series of 
pages can be presented without the user requesting the new pages to be 
loaded. 
 
<META HTTP-EQUIV=”Refresh” CONTENT=”1;URL=ht.htm”> </META> 
 

 
 

Generator 
This specifies what editor created the current page. In this case the 
attribute will indicate “Microsoft FrontPage 4.0.” 
 
Refresh 
This instructs the browser to refresh itself. The other instructions specify 
the time interval and the URL to be used. 
 
Description 
You can use the Meta element to embed information in the Head of your 
page that the search engines will use to display a description of your site. 
 
<META NAME=”description” CONTENT=”This is my company’s web site. 
The site contains information on our products and services.”></META> 
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Keywords 
You can use the Meta element to embed information in the Head of your 
page that the search engines will use for keywords when people are 
searching for your site. 
 
<META NAME=”keywords” CONTENT=”product name, service name, 
company name, country, province/state, industry, etc.”></META> 

 
Author 
You can embed the author’s name in a Meta element. 
 
<META NAME=”author” CONTENT=”Your Name”></META> 

 
Company 
Similarly you can embed the company name. 

 
<META NAME=”company” CONTENT=”Company Name”></META> 
 
Copyright 
<META NAME=”copyright” CONTENT=”Copyright © 1997 Your Name or 
Company name. All rights reserved.”></META> 
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Adding or Modifying META Elements 
 

In FrontPage, you can edit the META element by {Right Clicking} on your 
web page and selecting the option, “Page Properties.” In the “Page 
Properties” dialog box, {Click} on the “Custom” tab. The following dialog 
box appears: 
 
System Variables (HTTP-EQUIV): This section lists the Meta tags that use 
the HTTP-EQUIV element as the name portion of their name-value pairs. 
These Meta tags provide special instructions to a Web browser, such as a 
document’s expiration date or a display-refresh value. In the case of a 
document’s expiration date the Meta information instructs the cache to 
fetch a fresh copy of the document’s information.  
 

 
 

<META http-equiv="Expires" content="Tue, 20 Aug 1996 14:25:27 GMT"> 
 
The above results in: Expires: Tuesday, 20 Aug 1996 14:25:27 GMT 
which will instruct the proxy, and browser to remove this page from their 
respective caches on this day at this time. 
 
You can also specify to the browser to refresh itself after a number of 
seconds and what URL to load using the display-refresh value. 
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Add: This button allows you to add a new Meta tag. 
Modify: This button allows you to modify an existing Meta tag.  
Remove: This button allows you to remove an existing Meta tag. 

 
User Variables: This section lists the Meta tags defined by the user. 
Examples include keywords, description, author, copyright etc. 

 
 
Adding sound to an HTML page 
  

Depending on the browser that the client is using you can embed 
background audio that will play when the page is loaded. This option 
should be used cautiously as it can add significantly to the amount of time 
required to download the page. The browser must first download the audio 
file and then start the player software or plug-in; this can seem to take an 
extremely long time over some connections. 

 
 
<EMBED> 
 

The <EMBED></EMBED> element is used to place background audio in a 
page, it is supported by Netscape Navigator, and some ActiveX 
extensions in Internet Explorer. The Embed element has the following 
attributes: 
 
SRC:  
defines the URL of the sound file. 
 
CONTROLS:  
You have your choice of several controls including console, small console, 
play button, etc. 
 
AUTOSTART:  
when set to true the sound will start once the sound file is downloaded. 
 
HIDDEN:  
when set to true it will hide the controls, default is false. 
 
LOOP: 
defines how many times the sound file will play. 
 
VOLUME: 
sets the default volume when playing begins. 
 
HEIGHT: 
in pixels depends on choice of controls. 
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WIDTH:  
in pixels depends on choice of controls. 

 

 
 

The following sound formats are supported: .WAV or .AU audio files, or 
.MID midi files. 
 
Note: To fully utilize the attributes of <EMBED> in the FrontPage Editor, 
you will have to switch to the HTML View and edit the source.  

 
 
Embedding Background Audio 
 

1. In the FrontPage Editor, {Click} on the  Insert Plug In button. 
2. In the Plug In Properties dialog box, {Click} on the Browse button and 

locate the audio file you want to embed in your document. 
3. Go to: C:\fpfiles\special\ring.wav. 
4. Save your work and preview it in your browser. 
 
 

<BGSOUND> 
  

The <BGSOUND></BGSOUND> element is used to place background 
audio in a page, it is supported by Internet Explorer. BGSound has the 
following the following attributes: 

 
SRC:  
defines the URL of the sound file. 
 
LOOP:  
defines how many times the sound file will play. 
 
DELAY:  
defines the delay between loops. 
 
TITLE:  
the text that describes the sound. 
 

 
 
The following sound formats are supported: .WAV or .AU audio files, or 
.MID midi files. 
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Inserting a Background Sound 
 
In the FrontPage Editor, locate the “File” menu and select the “Properties” 
option. To add a sound, {Click} on the “General Tab” if it is not already 
selected.  
 

 
 
In the Background Sound section, select the location of sound by 
{Clicking} on the Browse button. You can choose to have the sound 
“Loop” a certain number of times, or place continuously.  
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<MARQUEE> 
  

The <MARQUEE></MARQUEE> element defines text that is displayed in 
an animated region of the browser. 
 
WIDTH: 
of the marquee in pixels. 
 
HEIGHT: 
of the marquee in pixels. 
 
LOOP: 
defines how many times the text will travel through the space. 
 
BGCOLOR: 
defines the background color of the marquee. 
 
BEHAVIOR: 
defines how the text should move in the marquee. 
 
SCROLLDELAY: 
sets the number of milliseconds before refreshes. 
 

 
 
The Marquee element is currently only supported by Internet Explorer, 
Navigator will only display the text between the <MARQUEE> and 
</MARQUEE> tags. 
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Inserting the Marquee Element 
 
The Marquee element can be inserted in a web page by {Clicking} on the 
“Insert” menu and choosing the option, “Components…. Marquee.” The 
Marquee Element dialog box appears allowing you to edit the marquee’s 
properties. 
 

 
 
 
<BLINK> 
 

The <BLINK></BLINK> element is supported by Navigator. It will cause 
text to blink. You can combine it with most text formatting for the desired 
effect. The element has no attributes.  
 

 
 
 
Adding the Blink Element 
 

To add the Blink element to an area of text, follow these steps: 
 
1. Select an area of text and {Right Click} on the selection. 
2. From the pop up menu, select the option “Font Properties.” 
3. In the “Font Properties” place a check mark in the <BLINK></BLINK> 

box.  
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FrontPage Tip 
 

 
Use the <BLINK></BLINK> elements with caution as it is considered to be 
annoying by repeat visitors. Only use this element on a small area of text 
that changes regularly. 
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Chapter 12 – Exercise 1 – Adding Client Pull, Server Push 
 

In this exercise, you are going to modify a series of html pages so that 
each page contains a META element that causes the browser to load 
another page in a specific period of time.  The result will appear to be a 
single animated page. 
 

Procedure 
 

1. In FrontPage {Click} “Open” and locate the file called ft.htm in the 
following directory: C:\fpfiles\special\ft.htm 

 
2. {Right Click} anywhere within this page and select “Page Properties” 

from the pop up menu. Within the “Page Properties” dialog box, {Click} 
on the “Custom” tab. 

 
3. {Click} on the “Add” button in the Systems Variables section and in the 

Name field call it Refresh. 
 
4. In the Value field, enter 5; URL=ftp.htm 
 
5. The Custom Properties dialog box should look like the following: 
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6. {Click} the “OK” button. 
 

 
7. Save the file. 
 
8. Insert a META tag in ftp.htm that points to ftpg.htm and save the file. 
 
9. Insert a META tag in ftpg.htm that points to frontpage.htm and save the 

file. 
 
10. Preview the file ft.htm. 

 
 
Chapter 12 – Optional Exercise  
 

1. Create a new file to test the MARQUEE and BLINK. (Make the 
background page color white, name the file test or sample and save 
the file) 

 
2. Add some of the other META tags to your homepage, 

 
3. Add a MARQUEE element 

 
4. Add a BLINK element  

 
5. Make the text in both larger and colored 

 
6. Save your file and view in both Navigator and Explorer 

 
7. Experiment with some of the other attributes of the MARQUEE 

element 
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Review Questions 
 

1. Where do the Meta tags go in the HTML Document? 
 
 
2. Name three uses for the Meta element information. 
 
 
3. How can you add sound to an HTML page? 
 
 
4. How do you set the properties of the Blink element? 
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Summary  
 

As a result of this chapter, you should be able to:  
 
• Create animated pages using the Meta element 
 
• Use the Meta element to add information to your pages that is relevant 

to Internet search engines and people viewing your source code 
 
• Add background sound to an HTML page 
 
• Add a Marquee 
 
• Add Blinking text 
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13 
 

Page Layout and Design 
Considerations 
 

 
This chapter teaches you to use HTML elements in an effective manner to 
control page layout. You will also be introduced to different design 
considerations you have to make. 

 
Objectives 

 
Upon completing this section, you should be able to:  

 
1. Use Technical Design Considerations in planning an HTML page or 

project 
 

2. Discuss Effective Page Layout 
 

3.  Plan a successful web site 
 

4.  Create a web site that is easily navigated 
  
Prerequisites 
 

• Multiple browsers to ensure that your page looks and functions 
identically in different browsers. 
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Technical Design Considerations 
 

Screen Resolution  
Screen resolution is dependent on the hardware and settings of the 
computer viewing your page. It is measured in pixels. When designing 
your pages you should make sure that they look good at the lowest 
resolution. The maximum guaranteed viewable area on a PC is 600 X 
280. This takes into account that the browser is actually using some of the 
viewable space. 
  

 
 
A. 640 X 480 
B. 800 X 600 
C. 1024 X 768 
D. 1280 X 1024 
E. Others, Web TV 

 
 

Color Depth 
Another factor determined by the hardware of the surfer’s computer is the 
number of supported colors.  The video card or the current video settings 
can limit the color range.  On a PC the video driver defaults to 16 colors 
and in many cases older video cards only support 16 colors. Designers 
should develop their graphics with a 216-color palette or the Netscape 
supported palette.  Graphics should be viewed at 16 colors to ensure they 
look good. 
  
• 16 colors 
• 256 colors 
• 216 colors 
 
Reducing the colors used in graphics has the additional benefit of 
reducing the file size, allowing faster downloading. 
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Document Size vs. Download Time 
Probably the biggest technical design consideration is the overall size of 
the page versus the time it takes to load on the surfer’s computer. Several 
things affect the speed at which a browser receives your page. The 
primary one is the speed of the user’s connection to the Internet; usually 
controlled by the surfer’s modem speed. This factor is out of the control of 
the designer. 
  
As a designer you should add up the following components to calculate 
the overall size of your web page:  

A. The size of the html page in bytes. 
B. The size of any graphics in bytes. 
C. The size of any embedded audio files in bytes. 
D. The size of any ActiveX objects or JAVA applets. 

 
Page Size = HTML page + Graphics + audio + other (ActiveX and/or 
JAVA) 
 
14.4 Kbps represents Kilobits per second or 14400 bps or (14400/8) 1800 
Bps (bytes per second). A 50 KB (Kilo Byte) graphics file will take 
(50000/1800) 27 seconds to download. At 28.8 Kbps it will take half that 
time 13-14 seconds. At 33.3 Kbps it will take approximately 12 seconds. 
 
Given that modem speed is a big limitation for most surfers you should not 
overload your pages. You should give the surfer the option to go to pages 
that are heavy with graphics, sound or JAVA applets.  Recognizing that 
many people surf with their graphics off you will also want to ensure that 
you effectively use the Alt Text attribute for your graphics.  
 
Technical Design Guidelines for Internet Applications 

• Use plug-ins and applets sparingly 
• Keep total page size less than 75KB (45 seconds @ 14.4) 
• Let users choose to view graphics intensive pages 
• Keep graphics less than 50KB (use thumbnails to give the user the 

choice to link to larger versions of the same image) 
• Use interlaced graphics (don’t use for backgrounds) 

 
FrontPage gives you approximate or estimated download times.  Select 
the desired baud rate by {Left Clicking} on the panel. 
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Page Loading – HTTP 1.0 Differences with HTTP 1.1 
Many questions come up over how a page is loaded, and a lot of that can 
be answered by the way the protocol that transports the page from the 
server to the web client works.  
  
1. The HTML page is retrieved. This is done through one connection to 

the server. The content of the page is then parsed by the browser for 
other elements that need to be downloaded like graphics, sound, 
ActiveX objects, or JAVA applets. 

  
2. Separate connections to the server are created for the other elements 

in the page, and each element is downloaded individually. Each one of 
these connections would be considered a hit by the web server, and 
are entered into the web server log. 

 
3. Since the TCP/IP protocol can have several connections open at once 

between the server and the web client, more than one element is 
downloaded at a time. This is why the status bar at the bottom of the 
browser shows the percentage of the file downloaded. The status 
alternates between different sizes as the information for each 
connection reaches the browser. 

 
Future web servers and web client software will support HTTP 1.1, which 
has several enhancements over HTTP 1.0. The major enhancement is 
that only one connection will be established for the page and all the 
elements that need to be downloaded. This will reduce the number of 
connections that must be opened and maintained at the server and will 
decrease download time. 

 
 

Browser Compatibility & Quirks 
Web client software is written by a number of companies and as such 
there are a number of differences between the browsers in the way that 
they interpret standard HTML code. 
  
One difference is the way in which the browsers draw tables. Internet 
Explorer will redisplay the table as new elements fill in the cells. Navigator 
4 downloads all the elements before displaying the table and does not 
perform multiple redraws as the table fills with data. 
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Page layout 
  

An HTML page starts in the top left corner and extends to the right and 
down with no fixed boundary.. This means a page can be infinitely long 
and wide. This bothers many designers as they are used to having 
boundaries to work with. 
 

 
 
Keep in mind that people reading English are trained to start in the top left 
of a page and finish at the bottom right. It is a good idea to start the theme 
of the page in the top left or the top center of the page for this reason. 
Page navigation controls should be located at the bottom right hand side 
of the page to make it easy to select the next page or return to the 
previous page. 

 
Page Layout Guidelines 

  
1. In most cases your pages should not require the viewer to scroll to the 

right. The maximum width of a page should be 600 pixels in order to be 
displayed properly, regardless of the display resolution. 

 
2. Recommended components of a home page: 

i. E-mail address (E.g. webmaster@whatever.com) 
ii. Mailing address 
iii. Phone numbers (800 numbers plus local area code and number. 

Remember not everyone one in the world has access to your 800 
number) 

iv. Interactive component that encourages repeat visits by your 
target audience 

v. Look, feel and message should reflect the organization 
vi. Information that is relevant to the target audience 
vii. Directions to what your target audience wants to know or do 

(PRE and/or Post Sale) 
 

3. To control a page you may want to create a table with a maximum size 
of 600 pixels and contain the page inside the table. 
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4. When deciding to use a Background Image that has a distinct left side 
you should make sure it is 1280 pixels wide, because the browser tiles 
the background image, and anything smaller will appear again on the 
right of the page when viewed at high resolutions. 

 
5. Use the DIV and CENTER element to control layout. (Div creates 

divisions within the document that do not have preformatted spacing 
associated with them, like paragraphs) You can control the alignment 
of objects with the alignment attribute of the DIV element.  E.g. left for 
backgrounds that are on the left. 

 
6. To create attractive looking forms you should use a table to control the 

layout of the form elements. 
 

7. Web pages should use white space at the borders. This makes the 
pages easier to look at and to read.  Printed pages usually have white 
space at the left and right hand sides; as well, at the top and bottom of 
the page. This effect can be achieved by centering the contents of the 
page. 

  
8. Frames are good for keeping people in your site. Careful consideration 

must be given to using Frames, as they require Frames-capable 
browsers.  Always remember to provide valuable information in the 
NoFrames section of the Frameset. 

 
9. You should be consistent in your layout across multiple pages, people 

become comfortable with the format, and begin to expect it. 
 

10.  Bigger is better. If things are too small they will strain the viewer’s 
eyes and it will not be comfortable for them.  General text areas should 
be 10 pt. or larger as this approximates an experience similar to 
reading a newspaper. 

 
11.  You should vary sizes for texture. When everything is the same size it 

becomes very boring. 
 

12.  Blinking text should only be used in situations where the information is 
changing frequently. 

 
13.  Be sure to use case properly. Mix upper and lower case as required or 

for effect. Documents done in all UPPER case are hard to read. 
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Site Design Factors and Criteria 
  

When developing a web site from scratch you should first answer the 
questions related to why people will be visiting the site in the first place. Is 
it for pre or post sale support, to purchase something, or find out more 
about the company? Your web site should be part of your business plan or 
marketing plan and there should be established goals and objectives for 
what it is to accomplish.  Once you know what problem you are trying to 
solve with the web site you can start your design. 
 
In general a site should be intuitive for the person visiting it. It should be 
very easy for them to contact your organization at any time and they 
should be able to locate the information they are looking for in three to five 
mouse {Clicks}. 

 
1. The Home page should be simple and fast. 
2. The Home page should answer some basic questions for the surfer: 

i. Is this the organization I was looking for? 
ii. Do they have what I am looking for? 
iii. How can I contact them? 
iv. How do I get what I want now? 
 

Site Layout and Navigation 
  

1. Navigation controls should be located across the top or the right hand 
side of the page. This will locate your navigation controls close to the 
browser’s controls for movement and up and down scrolling. 

 
2. As previously mentioned you should only have 3 to 5 mouse {Clicks} to 

move from start to destination. People do not like to hunt for an 
answer. 

 
3. Create sub sites to simplify navigation, and for marketability. E.g. 

education.novell.com, insight.netscape.com. 
 



 
 

Learn Web Development in a classroom @  http://www.xnu.com Call 1-416-675-1881 185 
 

Review Questions 
 

1. What is the maximum guaranteed viewable area on a PC? 
 
 
2. Give two reasons why you would want to reduce colors in graphics? 
 
 
3. What components do you add together to find your page size? 
 
 
4. How many Bytes per second can a 14.4 modem receive? 
 
 
5. Name three methods of controlling the positioning of text and objects 

on a page? 
 
 
6. What must you be check for when using a background image? 
 
 
7. How many mouse {Clicks} are reasonable for surfers to make to get to 

the information they are after? 
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Summary 
 

As a result of this chapter, you should be able to:  
 
1. Use Technical Design Considerations in planning an HTML page or 

project 
 

2. Discuss Effective Page Layout 
 

3. Plan a successful web site 
 

4. Create a web site that is easily navigated 
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14 
 

Cascading Style Sheets 
 

This chapter helps you make use of the latest power feature in HTML 
page creation and page control, Cascading Style Sheets. 

 
Objectives 

 
Upon completing this section, you should be able to: 

 
1. Describe how to use a Cascading Style Sheet 

 
2. Add an Inline Style 

 
3. Add an Embedded Style Sheet 

 
Prerequisites 
 

Cascading Style Sheets are currently supported by: 
 

• Netscape Navigator 4.0 or greater 
 

• Microsoft Internet Explorer 3.0 or greater 
 
 



 

188 XtraNet U – The place to learn how to develop for the web – http://www.xnu.com 
 

Introduction to Cascading Style Sheets  
 

In the past, Web Page designers have been frustrated by the lack of 
control they have over the appearance of a page. Cascading Style Sheets 
provide designers with increased control over how a web browser displays 
their pages.  

 
For the experienced designer, Cascading Style Sheets will be a welcome 
feature that saves a lot of time normally spent on repetitive style formatting 
commands. With Cascading Style Sheets you can specify a particular font 
size in points or pixels, designate font face and style, and control spacing 
and indentation, etc.  
There are three ways you can add Style Information to your web page: 
 

1. Inline styles 
2. Embedded style sheets 
3. Linked style sheets 

 
At the present time, Microsoft Internet Explorer (3.0) and Netscape 
Communicator 4.0 provide the most extensive support for Cascading Style 
Sheets. 
 
The specifications for the evolving CSS standard can be found at the W3C 
Consortium's Web page at http://www.w3.org/. 

 
A cascading style sheet consists of one or more rules. There are two 
different types of rules:  
 
1. Rules associating an element, a group of elements, an element in a 

particular context, or some combination of these with a set of style 
properties and values. This is the usual type of rule in a style sheet.  

 
2. Rules used to set information about the style sheet such as its title, 

author, etc., as well as specifying imported style sheets and additions 
to the CSS standard. 
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Inline Styles 
 
The first method of applying cascading style sheet properties and values 
to an element on a page is called inline styles. The style sheet properties 
are applied to content within the <BODY> </BODY> tags.  For instance, 
you can designate that a certain paragraph in your document uses custom 
indentation settings by applying inline style sheet commands to that 
paragraph.  Inline styles override both embedded and external style sheet 
properties.   
 
When you select certain elements or formatting effects FrontPage will 
apply an inline style. {Right Click} in a paragraph and choose Paragraph... 
from the popup menu. Any settings that you make in the Indentation or 
Spacing fields will be written as CSS style commands and specified within 
the paragraph element as the value of the Style attribute. 
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HTML View: 

 
 

Normal View: 

 
 
 
NOTE: The CSS standards allow the specification of style commands for 
paragraphs, other than indentation and spacing but FrontPage does not 
provide dialog boxes to insert those commands. To apply additional inline 
styles to elements in your pages you will have to add them using the 
HTML editor view. 
 
An inline style is only valid for the one instance of the element in which it is 
applied. 
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Embedded Style Sheets  
 

Embedded Style Sheets make use of the <STYLE> </STYLE> element in 
the Head of the document. A required attribute of the Style element is the 
TYPE attribute and it must be set to a value of “text/css”. Again you will 
need to know exactly what you want to achieve and have all the formatting 
commands handy. Another disadvantage, like the Inline Style, is that it 
only applies to one document. 
 
 

Creating an Embedded Style Sheet 
  
An embedded style sheet is easily created in FrontPage by following these 
steps:  
 
1. Switch to Normal View in the FrontPage Editor and {Click} on the 

“Format” menu. 
  

2. Select the option “Style…” from the Format Menu.  
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3. The style dialog box allows you to choose a page element from the list 
in the “styles:” window. You then can {Click} on the modify button to 
launch the Modify Style dialog box where you can associate style 
commands with the element that was selected.  

 

 
 
4. To apply a style, {Click} on the “format” button. A pop-out menu giving 

you options for  “Font”, “Paragraph”, “Border”, “Numbering” and 
“Position” allows you to choose the type of style command to apply. 

 
5. You can apply multiple style commands to as many elements as you 

wish. When you {Click} the OK button on the Style dialog box 
FrontPage will create an embedded style sheet using the style 
element. 

 
6. You will need to add the type attribute to the code generated by 

FrontPage so that the HTML looks as follows: 
<STYLE TYPE=”text/css”> 
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HTML View: 

 
 

Normal View: 

 
 

Note that the STYLE defined in the HEAD section has made all the text 
the same font face and color.  In addition, there is an Inline STYLE applied 
to the second paragraph. 
 
NOTE: Some browsers are not CSS-compliant and will display the 
contents of the STYLE element in the document window.  For this reason 
it is a good idea to surround an embedded style sheet with an HTML 
comment. This will cause the content to be ignored by non-CSS browsers, 
but still interpreted by CSS compliant browsers. FrontPage automatically 
inserts a comment around an embedded style sheet.
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Linked Style Sheets   
 
The preferred method of adding styles to a web page is to link a separate 
file that contains all of the formatting information. A style sheet file is a text 
file with a file extension of .css.  This file can be linked to multiple HTML 
pages and you can link multiple style sheets to one document. 
 
To create a linked style sheet: 
 

1. Switch to Normal View in FrontPage and {Click} on the File menu. 
 
2. Point to New and select Page 
 
3. Select the Style Sheets Tab and select the appropriate style you 

want. 
 
4. You can now create your own style by Clicking on the Format menu 

and then the Style Button. 
 
5. In the Style Dialogue Box, you are able to create your own style as 

we did with creating embedded style sheets. 
 
6. To create this file into an external Cascading Style Sheet, you have 

to save it with an extension of .CSS 
 

To link a style sheet: 
 

1. {Click} on the “Format” menu and select “Style Sheet Links” 
 
2. In the “Link Style Sheet” dialog box {Click} on the “Add” button 

 
3. Navigate to the style sheet that you wish to link to or enter the URL 

and {Click} OK 
 

4. The style sheet should now be listed in the dialog box; {Click} OK 
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CLASSES AND IDS  
 

Cascading style sheets let you associate a CLASS or an ID attribute with 
a set of style properties and values, so that you can format a particular 
element instance in a certain way. 
 
In a style sheet a CLASS will start with a dot and an ID will start with a 
number symbol: 
 

.classname  = CLASS 
#idname  = ID 
 

Style commands can be attached to a CLASS or ID incidence in the 
document the same way they are attached to elements. 
 

 
 

 
 
 

CLASSES 
  

A class is simply a group of elements, possibly scattered throughout a 
document, all of which have the same value for their CLASS attribute.  

 
To utilize a class, you set the CLASS attribute of as many elements as 
you wish to the same value. 

 
IDs 

  
While many elements can have the same CLASS attribute value, only one 
element in any document can have a particular ID attribute value. IDs are 
intended to be unique identifiers for elements in a document.  
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Defining Classes  
 

To define a CLASS you follow much the same procedure as creating an 
embedded Style Sheet except you do not attach a Style attribute to an 
element, rather you create a CLASS and name it appropriately: 
 
1. Switch to Normal View in the FrontPage Editor and {Click} on the 

“Format” menu. 
 

2. Select the option “Style…” from the Format Menu. 
 

3. Select “New”. 
 

4. The “New Style” Dialog box pops up.  Name your Style. 
 

 
 

5. To define a style, {Click} on the “format” button. A pop-out menu giving 
you options for  “Font”, “Paragraph”, “Border”, “Numbering” and 
“Position” allows you to choose the type of style command to apply. 

 
6. To finish this process {Click} OK. 
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Applying New Styles  
 

When you create new styles using either Classes or IDs FrontPage adds 
the Class or ID name to the Style list that you can access through the 
dropdown Style Menu on the Formatting Toolbar. 
 
You can easily apply the styles to portions of your document: 
 

1. Select the content you want to apply the style to. 
 
2. {Click} the Style dropdown menu. 

 
3. Select the new style from the list. 
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Chapter 14 – Exercise 1 – Inline Styles 
 

In this exercise, you will add an Inline Style to a document. 
 

Procedure 
 
1. Open C:\Fpfiles\css\doc2.htm 
 
2. {Right Click} in the paragraph and select “Paragraph” 
 
3. In the indentation section enter a setting of 35 in the “Before text” field 

 
4. {Click} “OK.” 

 
5. Save your work and preview your page in either Explorer or Netscape 

 
 
Your work should look similar to the following: 
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Chapter 14 – Exercise 2 – Embedded Styles 
 

In this exercise, you will add an Embedded Style Sheet to a document. 
 

Procedure 
 
1. Open C:\Fpfiles\css\doc3.htm 
 
2. Go to the Format menu and select “Style” from the list of options. 

 
3. Select the H2 element from the styles list 

• {Click} modify then Format then Choose Font 
• {Click} on the color dropdown 
• Choose the green color square 
• {Click} OK 
• {Click} OK 

 
4. In the “List” dropdown select “All HTML Tags” 
 
5. Select the P element from the styles list 

• {Click} modify then Format then Choose Font 
• Set the color to red 
• Set the size to 12pt 
• In the “Font” field type “Garamond, serif” 
• {Click} OK on all dialog boxes 

 
6. Save and preview your document in Internet Explorer or Navigator v4. 

Your code should look similar to this: 
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Chapter 14 – Exercise 3 – Linked Style Sheets 
 

In this exercise you will link a style sheet to a document 
 

Procedure 
 

1. Open C:\Fpfiles\css\Doc3.htm. 
 
2. Choose “Style Sheet Links” from the Format menu 

 
3. {Click} on the “Add” button 

 
4. Navigate to find the file C:\Fpfiles\css\Stylesht.css and {Click} OK 

 
5. {Click} OK on the “Link Style Sheet” dialog box 

 

 
 

6. Save and preview your document in the browser. 
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Review Questions 
 

1. What are three ways to add style information to your web pages? 
 
 
2. Give two disadvantages of Embedded Style Sheets. 
 
 
3. How is a Style Sheet linked to an HTML document? 
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Summary 
 

As a result of this chapter, you should be able to:  
 
• Describe how to use a Cascading Style Sheet 
 
• Add an Inline Style 
 
• Add an Embedded Style Sheet 
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15 
 

JAVA and JavaScript Introduction 
 
 

In this chapter you are introduced to what JAVA is, and how to add JAVA 
applets to your web pages. You are also introduced to JAVA Script and 
how to add it to your web pages. 

 
Objectives 

 
Upon completing this section, you should be able to:  

 
1. Describe JAVA 
 
2. Add a JAVA Applet to a page 

 
3. Describe JavaScript 

 
4. Add JavaScript to an HTML page 

 
Prerequisites 
 

• Internet Explorer 3.0 or greater (IE 3.0 Supports JAVA with limited 
support for JavaScript )  

 
• Navigator 2.0 or greater 
 
• JAVA is Platform Independent 
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JAVA 
 

JAVA, developed by Sun Microsystems, is a powerful, cross-platform and 
device-independent programming language.  An applet, for those not 
familiar with the term, is the name of mini-applications created with the 
Java programming language. The creation of applets is beyond the scope 
of this course. In FrontPage there is a menu option that allows you to 
insert a Java applet into a page.  
 

 
 
That brings up the following dialog box: 
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The options presented in the “Java Applet Properties…” dialog box refer to 
the properties, and sub-elements of the <APPLET> tag. 

 
 
<APPLET>   

 
Designates a Java applet. Instead of containing the code required to 
perform a task, this tag contains a reference to the code needed to 
perform the task. 
 
The Applet element has one sub-element; the <PARAM> element that 
tells the applet how to behave or operates. 
 
Applet has the following attributes: 

 
CODEBASE:  
Directory or folder where the applet(s) are located. 
 
CODE: 
Defines the compiled applet that is to be loaded. 
 
WIDTH: 
Determines the width of the area reserved for the applet in the browser 
Measured in pixels. 
 
HEIGHT: 
Determines the height of the area reserved for the applet in the browser. 
Measured in pixels. 

 
 
<PARAM>  

This tag passes a parameter to the applet. It has two attributes: 
 
NAME: 
Names the parameter for recognition by the applet. 
 
VALUE: 
Defines a value for the parameter named by the NAME attribute. All data 
is passed to the applet as a string variable. 
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The following dialog box allows you to enter the <APPLET> elements 
attributes, and add the necessary <PARAM> elements required by the 
JAVA application. 
 

 
 
HTML View: 

 
 
Normal View: 
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When using JAVA in your pages, it is important to be aware that JAVA 
support is not universal. If, like many authors, you are showcasing your 
use of JAVA on the page, it is advisable to include text in the document 
that alerts viewers to this fact. This is especially true when the applet itself 
is the centerpiece of the document.  

 
 
JavaScript  
 

JavaScript is a programming language that allows scripting of events, 
objects and actions to create Internet applications. It uses two elements 
the <SCRIPT> </SCRIPT> and <!--  the comment - ->. The script element 
lets the browser know what type of script it is with the LANGUAGE 
attribute. The comment encloses the actual JavaScript code so that 
browsers that don’t support scripting ignore the code. 
 
Since JavaScript is embedded in the HTML page it is interpreted by the 
browser when the page is loaded.  This contrasts to JAVA applets that are 
compiled programs downloaded from the web server to the browser and 
run inside the browser. The easiest way to add JavaScript to your web 
pages is to type it in the HTML View. 
 

 
 
The above code takes two numbers from the textboxes, converts them 
from letters to numbers, adds them together and pops up the result. 
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Result: 

 
 
Actual JavaScript programming is outside the scope of this course.  
Scripts are available for download from a variety of sources.  To use 
JavaScript in FrontPage you must enter it into HTML View.  Alternately, 
you can use FrontPage’s DHTML Effects to add predefined JavaScript to 
your page. 
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Chapter 15 - Exercise 1 - Inserting a JAVA Applet 
 

In this exercise, you will insert into your homepage, a JAVA applet that 
displays the time on an analog clock. 
 

Procedure 
 

1. Place your cursor where you would like to insert the JAVA Applet. 
 
2. Select “Java Applet” located on the Insert ! Advanced menu 

 
 

 
3. Type the filename into the Applet Source field Lake.class 
 
4. Add the message: Your browser needs to support JAVA to view this 

page. 
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5. Add a parameter with the name IMAGE and the value mistmorn.jpg. 

 

 
 

6. Change the width to 436 and height to 220.  
 

 
 

7. {Click} OK. Save the file in c:\fpfiles\java\ and Preview it. It is 
important that the .class and .jpg and .htm file all be in the same 
directory to work! 
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Chapter 15 – Optional Exercise 
 

1. Add the JavaScript from the previous page to an html page. 
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Review Questions 
 

1. Who created the JAVA programming language? 
 
 

2. What does the PARAM element do? 
 
 

3. Why is the actual JavaScript code placed within a comment element? 
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Summary 
 

As a result of this chapter, you should be able to:  
 
• Describe JAVA 
 
• Add an APPLET to a web page 
 
• Describe JavaScript 
 
• Add JavaScript to an HTML page 
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16 
 

ActiveX Objects and VBScript 
Introduction 
 
 
In this chapter you learn about ActiveX and add an object to a web page. 
 
Objectives 

 
Upon completing this section, you should be able to:  
 
1. Describe ActiveX 
 
2. Add and ActiveX object to a web page 

 
3. Describe VBScript 

 
4. Add some VBScript to an HTML page 

  
Prerequisites 
 

• Internet Explorer 3.0 or greater 
 
• Navigator 3.0 or greater with Plug-in (For ActiveX support, Navigator 

does not support VBScript) 
 
• ActiveX currently requires Windows 95 or Windows NT operating 

systems 
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ActiveX Support 
 

The OBJECT element lets you insert a program called an Internet Control 
into an HTML page. ActiveX is a Microsoft standard for Internet Controls 
and is subject to change independent of the W3C and the HTML standard.  

 
ActiveX controls (formerly known as OLE controls) are component 
objects designed to be reused within applications. There are many 
ActiveX controls in existence developed by Microsoft and by third-party 
developers. You can use these controls in Web page development. 

In this section, you learn how to add ActiveX to an HTML page by using 
the <OBJECT> tag. You will also learn about the <PARAM> tag, which 
makes it possible to set the objects properties. This section focuses 
primarily on ActiveX controls, but the technique used to insert the 
controls is the same as that used for other types of objects.  

The <OBJECT> tag is a new element of HTML 3.0 that provides a 
standard way to add new types of media to an HTML page. 

 

Adding an ActiveX Control 
To add an ActiveX Control to your page, select the “ActiveX Control…” 
option from the Insert ! Advanced menu. 
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This will produce a selection box full of options. 

 
These options are the controls that are available on your computer. You 
can select the control you wish to use on your page and {Click} OK. 
Warning not all of the controls listed are for use on web pages, some 
are components of other software products. If we select the “Calendar 
Control 9.0”, there will be an active calendar on the web page. 

Normal View: 
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HTML View: 

 
ActiveX Controls are added to web pages using the <OBJECT> 
element, and the <PARAM> sub-element. 

 

<OBJECT>  
The <OBJECT> tag has a number of parameters that define the object, 
its location, and how it is presented on the HTML page. 

 
CLASSID: 
ActiveX controls, which are binary files, are installed on a user's 
computer and registered in the system registry with a unique class ID. 
The CLASSID parameter of the <OBJECT> tag contains a URL that 
uniquely identifies the object. Referencing the class ID of the registered 
control in the <OBJECT> tag inserts it into the HTML page and then the 
control displays itself. 

ActiveX controls are identified by a URL that uses a class ID identifier. 
The format for this URL is: 

"clsid:12345678-1234-1234-1234-123456789012" 

   
This example shows the <OBJECT> tag for the Calendar control. The 
CLASSID is the only parameter that is required by the <OBJECT> tag. 

<OBJECT classid="clsid:8E27C92B-1264-101C-8A2F-040224009C02"> 
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The class ID for an ActiveX control is placed in the registry when a control 
is installed. There are a number of tools you can use to retrieve this value. 
• ® Registry Editor (RegEdit)  This tool enables you to change settings 

in your system registry. You can also use it to view and copy the class 
ID for an object. 

• ® OLE Viewer  This utility is installed with the Win32 Software 
Development Kit (SDK). You can select the Copy HTML <object> Tag 
to Clipboard command from the Object menu to copy the tag and the 
class ID to the Clipboard. 

• ® ActiveX Control Insertion Device  This utility can also build the 
<OBJECT> tag for you and copy it to the Clipboard.    

 
ID: 
The ID parameter in the <OBJECT> tag is synonymous with the NAME 
parameter for standard controls. You can use the ID to refer to the object 
from VBScript. 

  
CODEBASE: 
This parameter is a URL that points to a file containing the 
implementation of an object. (It is explained in detail in the next topic.) 

NAME: 
This parameter is required when the object is on a form and needs to be 
included with other form fields when information is sent to the server.  

 
WIDTH, HEIGHT, ALIGN, HSPACE and VSPACE: 
These parameters affect the way an object is positioned and sized within 
an HTML page. 
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CodeBase 
If the object specified by the CLASSID parameter is not available on the 
user's computer the browser will use the CODEBASE parameter to 
determine where the object is located on the Internet server and 
download the files required to render the object. As with all files that can 
be downloaded, you should provide the user with the option of 
downloading the object and an alternative to the object if possible. 

For example, the browser will try to locate an ActiveX control on the 
local computer by first searching the registry. If the control is not 
registered the browser will download the object from the location 
specified in the CODEBASE parameter.  

Specifying the CODEBASE URL 
The CODEBASE parameter for the <OBJECT> tag contains a URL 
pointing to the implementation files for a given object. This URL is critical 
for downloading components because it must specify all files necessary 
to implement a particular object.  

This example downloads an ActiveX control by referencing the .ocx file: 

<OBJECT 
 ID="NewControl" 
 CLASSID="clsid:123-1234-123-123-" 
 CODEBASE="http://server/control.ocx"> 
</OBJECT> 
     

HTML authors can set the CODEBASE parameter to point to one of 
three file types, which are typically supplied by the developer of the 
control.  

• ® Portable executable file - This is a single executable file, such 
as an .ocx file or DLL, that is downloaded, installed, and 
registered by the browser. 

• ® .CAB (cabinet) file - This file contains one or more files, all of 
which are downloaded together in a compressed cabinet.  

• ® .INF file - This file specifies various files that need to be 
downloaded and set up for the .ocx to run.  
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VBScript   
 

VBScript is a programming language that allows scripting of events, 
objects and actions to create Internet applications. It uses two elements 
the <SCRIPT> <SCRIPT> and <!--  the comment - ->. The script element 
lets the browser know what type of script it is with the LANGUAGE 
attribute. The comment encloses the actual VBScript code so that 
browsers that don’t support scripting ignore the code. 
 
Since the VBScript is embedded in the HTML page it is interpreted by the 
client when the page is loaded and activated on an event like pressing a 
button. It is very handy for taking the output of one ActiveX control and 
passing it as input to another ActiveX control.  To use VBScript in your 
HTML documents with FrontPage we suggest you use HTML View. 
 

 
 
The above code takes two numbers from the textboxes converts them 
from letters to numbers, adds them together and pops up the result. 
 

 
 

Actual VBScript programming is outside the scope of this course. 
Note: VBScript is currently not supported in Navigator. 
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Chapter 16 – Exercise 1 – Adding an ActiveX Object 
 

In this exercise you will add the Calendar control to a page and view it in 
Microsoft’s Internet Explorer 3.0. 
 

Procedure 
 

1. Open the page ActiveX.htm in from the C:\Fpfiles\activex directory in 
your Internet Explorer browser. You will be creating a page similar to 
this ( You may need to adjust your browser settings to a lower security 
level in order to get the page to work.)  

 
2. Start a new document, or continue working with your existing 

document. 
 

3. {Click} on the ActiveX icon.  From the Insert Menu and then the 
Advanced Options. 

 
 

4. Choose the Calendar Control from the drop down list. 
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5. The Active-X Object is now inserted in your FrontPage Document. 
 

To change the properties for the Active-X Object just inserted, Right 
{Click} on the Object and {Click} on Active-X Control Properties, or {Click} 
on the Object and Press ALT-ENTER 
 
Active-X Control Properties – General, Color, Font 

 

 
 
The General, Color and Font options vary from object to object.  In this 
case, we are given the options that relate to the Calendar Control. 
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Active-X Control Properties – Object Tag 
 

 
 

The Object Tab contains the Name of the object.  The Layout options 
enable you to set the Objects alignment, horizontal/vertical spacing, the 
width and the height of the object.  You are also given the option of 
entering the alternate representation which links to another HTML 
document.  Finally, you can set the code base of where the Object is 
located. 
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Preview your document in Internet Explorer. It should look similar to the 
following: 
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Review Questions 
 

1. What element is used to support ActiveX controls? 
 
 
 
2. Why should you specify the codebase attribute? 
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Summary 
 

As a result of this chapter, you should be able to:  
 
• Describe ActiveX 
 
• Add an ActiveX object to a web page 
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Superscript <SUP> </SUP> ......... 54 
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Tables, Caption <CAPTION> 

</CAPTION>........................... 117 
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Tables, Header <TH> </TH> ...... 119 
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Toolbox Café  
Software 

 
32bit.com 
Easiest software download on the 
Internet 
www.32bit.com 
 
The Web Developer’s 
Virtual Library 
The illustrated Encyclopedia of Web 
Technology 
www.WDVL.com 
 
JavaScripts, HTML, 
Web design & 
Promotion 
Resources for development suing 
JavaScript, HTML, and CGI. 
www.algonet.se/~tools/index.h
tm 
 
Free Site Tools 
Free Website and Computer 
Resources – Tons of Webmaster Stuff 
http://www.freesitetools.com/ 
 
 

Web Hosting 
 
Online Marketing 
Quality Web Hosting 
www.olm.net 
1-877-265-6638 
 

Access 
 
Connect America 
International Dial Up Services 
www.connectamerica.com 
909-778-3640 
 
FlashNet Marketing, Inc. 
Internet access products and services 
available for resale and promotion 
www.flashopportunity.com 
1-877-225-5364 x480 
 
 

Internet Shows 
 

NetTalk Live 
Cool! Online and on cable! 
www.nettalklive.com  

 
Newsletters 

 
Tricks and Trinkets 
A very cool news letter! 
www.tricksandtrinkets.com 

E-commerce 
 
E-Commerce Exchange 
The online entrepreneur’s choice for 
e-commerce since 1989 
www.ecx.com 
1-800-748-6318 
                                         
InfiniteHorizon.com 
Easy E-commerce setup, JavaScript 
libraries, cgi-bin capability, web 
based e-mail, auto responders, 
stats, 24 hour technical support and 
more. 
www.virtualis.com/vr/ebabin/  
562.433.4891 
 

Associations 
 
Webgrrls International 
The women’s tech knowledge 
connection 
www.webgrrls.com 
 
The HTML Writers Guide 
International organization of Web 
authors 
www.hwg.org 
 

Training 
 
XNU.COM 
Web development training 
www.xnu.com 
info@xnu.com 
1-877-644-3444 
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